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About This Document

This manual explains how to use the S6SAE101A00SA1002 evaluation board. Make sure you read this manual before using

the product.

Handling and Use

Handling and use of this product and notes regarding its safe use are described in this manual.

Follow the instructions in the manuals to use this product.

Keep this manual handy so that you can refer to it anytime during use of this product.

Caution

The following precautions apply to the product described in this manual.

& WARNING

Indicates a potentially hazardous situation which could result in death or serious injury and/or a fault in the
user’s system if the product is not used correctly.

Electric shock,
Damage

Before performing any operation described in this manual, turn off all the power supplies to the system.
Performing such an operation with the power on may cause an electric shock or device fault.

Electric shock,
Damage

Once the product has been turned on, do not touch any metal part of it.
Doing so may cause an electric shock or device fault.

/\ cauTon

Indicates the presence of a hazard that may cause a minor or moderate injury, damages to this product or
devices connected to it, or may cause the loss of software resources and other properties such as data, if
the device is not used appropriately.

Cuts, Damage

Before moving the product, be sure to turn off all the power supplies and unplug the cables. Watch your
step when carrying the product. Do not use the product in an unstable location such as a place exposed to
strong vibration or a sloping surface. Doing so may cause the product to fall, resulting in an injury or fault.

The product contains sharp edges that are left unavoidably exposed, such as jumper plugs.

Cuts Handle the product with due care not to get injured with such pointed parts.
Do not place anything on the product or expose the product to physical shocks. Do not carry the product
Damage after the power has been turned on.
Doing so may cause a malfunction due to overloading or shock.
Since the product contains many electronic components, keep it away from direct sunlight, high
Damage temperature, and high humidity to prevent condensation. Do not use or store the product where it is
9 exposed to much dust or a strong magnetic or electric field for an extended period of time. Inappropriate
operating or storage environments may cause a fault.
Use the product within the ranges given in the specifications.
Damage Operation over the specified ranges may cause a fault.
To prevent electrostatic breakdown, do not let your finger or other object come into contact with the metal
Damage parts of any of the connectors. Before handling the product, touch a metal object (such as a door knob) to
discharge any static electricity from your body.
When turning the power ON or OFF, follow the relevant procedure as described in this document. Before
Damage turning the power on, in particular, be sure to finish making all the required connections. Furthermore, be
9 sure to configure and use the product by following the instructions given in this document. Using the
product incorrectly or inappropriately may cause a fault.
Because the product has no casing, it is recommended that it be stored in the original packaging.
Damage Transporting the product may cause a damage or fault. Therefore, keep the packaging materials and use

them when re-shipping the product.
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Typographic Conventions

Convention Usage

Courier New, 9pt.

Displays file locations, user entered text, and source code examples:
C:\ ...cd\icc\

CyDelay

Courier New

Consolas 9pt.
API and function names (when mentioned within body text)

If there is not response to the DOWNLOAD_MINIDRIVER command, the device may be in autobaud
mode.

Consolas

Arial,9pt in body text; 8pt in table text.

Italics Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

Represents menu paths:

File > Open File > Open > New Project

Displays commands, menu paths, and icon names in procedures:

Bold Click the File icon and then click Open.

loT Resources and Technical Support

Cypress provides a wealth of data at www.cypress.com/internet-things-iot to help you to select the right 10T device for your
design, and quickly and effectively integrate the device into your design. Cypress provides customer access to a wide range
of information, including technical documentation, schematic diagrams, product bill of materials, PCB layout information,
and software updates. Customers can acquire technical documentation and software from the Cypress Support Community
website (http://community.cypress.com/).

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 5
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1 Introduction

The Solar-Powered IoT Device Kit provides an easy-to-use platform for the development of a solar-powered I0T device with
BLE wireless connectivity. It includes the S6AE101A Energy Harvesting Power Management IC (PMIC) device, which is
ideal for solar- or light-powered Energy Harvesting Systems (EHS) since it only consumes 250 nA. The S6AE101A also
supports a hybrid EHS that uses a solar cell Energy Harvesting Device (EHD) along with a coin cell battery, and an optional
vibration EHD with external diode bridge. The output voltage from the S6AE101A is configurable from 1.1 V to 5.2 V,
supporting a broad range of device components for an 10T device. Also included in the kit is Cypress' EZ-BLE™ PRoC™
Module (CYBLE-022001-00), a fully integrated Bluetooth Low Energy (BLE) module solution that offers high flexibility for a
wide variety of 10T device uses. A USB port is provided by Cypress' USB-UART LP Bridge Controller device (CY7C65213).

Energy Harvesting Motherboard

Power Line
........ Optional Power Line

Battery for Hybrid .
(Optional)
.............................. 3x3mme
VOUT: 3.3~1.9V
y T Matching
CYPRESS Jumper 5 Component
Solar Cell Energy VSTORET ET CYPRESS
m— Harvesting B Bluetooth smart module
PMIC Data e CYBLE-022001-00
SEAE101A oo
= VOUT SET
Piezoelectric o
(Optional) o
.:I g 10.0x10.0mm 4 4 4 A
33v

SWDCLK
SWDIO

A J
CYPRESS
USB Serial
CY7C65213

sV Data |

\[0

BLE-USB Bridge

” B

Figure 1-1. Block Diagram of Development Kit

1.1 Features

The Solar Powered 10T Device Kit provides everything needed to develop a light-powered sensor node that transmits sensor
data using BLE:

B Operates using light (> 200 lux) energy harvested by the included solar cell
0 Supports the use of a vibration Energy Harvesting Device with an external diode bridge (not included)
[0 Supports the use of a coin cell battery (optional, not supplied)

B Supports BLE communication with a PC through the provided BLE-USB Bridge that is pre-programmed with custom
firmware for this kit

B Includes firmware that supports the following applications:
1 Bluetooth Low Energy (BLE) Beacon, transmitting data at 1.5 sec intervals with ambient light as low as 200 Ix
0 Wireless Sensor Node (WSN), transmitting data at 6 sec intervals with ambient light as low as 200 Ix

B Includes an expandable terminal on the Motherboard that can support the following:

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 6
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Reset button for EZ-BLE Module
JTAG header to debug EZ-BLE Module
Expandable sensor interface (I2C/UART/SPI/GPIO)

O 0O0o0ood

DIP switch for future expansion (Not mounted)
[0 LEDs for USB power and status

Includes reference schematic, BOM list, and layout data for easy design

Uses the following Cypress Devices:

[0 S6AE101A ultra low power Energy Harvesting PMIC
0 CYBLE-022001-00 EZ-BLE PRoC Module

0 CY7C65213 USB-UART LP Bridge Controller

0 MB39C022G LDO

1.2 Applications

The following are the applications that use the Solar Powered loT Device Kit:
m  Battery-less WSN

B |oT device that monitors various sensors

B BLE Beacon

B Wearable device

®  Building Energy Management System (BEMS)

®  Home Energy Management System (HEMS)

B Factory Energy Management System (FEMS)

®  Wireless lighting control

® Wireless HVAC sensor

B Security system

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 7
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2 Kit Introduction

2.1 Kit Contents

Figure 2-1 shows the Solar-powered IoT Device kit. See the list below for a description of the numbered items.

Figure 2-1. Solar-Powered IoT Device Kit

Energy Harvesting Motherboard
BLE-USB Bridge

Solar Module (Panasonic AM-1801)
Two jumper wires

220 pF Capacitor and 10Q Resistor*
USB Standard-A to Mini-B cable
Quick Start Guide

NoogprwNE

1 The 220 pF capacitor is an additional output capacitor. The 10Q resistor is for current measurement. See Appendix B Using Extra
Components for detailed information.

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B
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3 Software Installation

3.1 Installing Software

Follow these steps to install the S6SAE101A00SA1002 Solar-Powered loT Device Kit software:

1. Download and install the Solar-Powered 10T Device Kit software from www.cypress.com/energy-harvesting.
The Solar-Powered |oT Device Kit software is available in three different formats for download:

0 Solar-Powered IoT Device Kit Complete Setup: This installation package contains the files related to the Kkit.
However, it does not include the Windows Installer or Microsoft .NET framework packages. If these packages are
not on your computer, the installer directs you to download and install them from the Internet.

[0 Solar-Powered IoT Device Kit Only Package: This executable file installs only the kit contents, which include code
examples, hardware files, and user documents. This package can be used if all software prerequisites are installed
on your computer.

[0 Solar-Powered IoT Device Kit ISO: This file is a complete package, stored in a CD-ROM image format that can be
used to create a CD, or extract using ISO extraction programs, such as WinZip or WinRAR. This file includes all
the required software, utilities, drivers, hardware files, and user documents.

2. Run Install Solar-Powered 10T Device Kit to start the installation.
3. Select the folder to install the Solar-Powered |oT Device Kit-related files. Choose the directory and click Next.
Solar-Powered IoT Device Kit - InstallShield Wizard X

Welcome to the InstallShield Wizard for
Solar-Powered loT Device Kit

The InstallShield Wizard will install Solar-Powered 10T Device
Kit onyour computer. To continue, click MNesxt.

Selectfolder where setup will install files

d " I Install Solar-Powered [0T Device Kitto:

< Back | MNext » ‘ i Cancel ]

Figure 3-1. Selecting Directory

4. The Solar-Powered IoT Device Kit ISO installer automatically installs the required software. If the required software is
not present in your computer., the Solar-Powered loT Device Kit Setup installer directs you to download the required
software from the Internet.

5. Choose the Installation Type, which can be Typical, Custom, or Complete in the Product Installation Overview window.
Click Next.

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 9
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Software Installation

' Cylnstaller for Solar-Powered IoT Device

[ Next > H Cancel ]

Product Installation Overview
Choose the install type that best suits your needs

Choose the type of installation

Product:
Solar-Powered IoT Device Kit

Installation Type:

Typical v

features of Solar-Powered IoT
Device Kit.

installation.

Figure 3-2. Selecting Installation Type

Read the Cypress License Agreement and accept the terms in the license agreement. Click Next to continue with the

License Agreement

You must read and accept the license before vou install the software

License Agreement

CYPRESS END USER
LICENSE AGREEMENT

PLEASE READ THIS END USER LICENSE AGREEMENT
("Agreement") CAREFULLY BEFORE DOWNLOADING,
INSTALLING, OR USING THIS SOFTWARE AND
ACCOMPANYING DOCUMENTATION ("Software"). BY

TYWAATITATT MAATATAT TATOT AT T TATA, M TTOTAT/ TTIT OMTTTIITATITY

i »

@)1 accept the terms in the license agreement

(1 do not accept the terms in the license agreement

’ < Back ” Maxt > H Cancal ]

Figure 3-3. Accepting the License Agreement

When the installation begins, a list of packages appears on the installation page. A green check mark appears next to

each package after successful installation. Click Finish to complete the Solar-Powered 10T Device Kit installation.

complete the Solar-Powered loT Device Kit installation.

Enter your contact information or select the Continue Without Contact Information check box. Click Finish to

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B
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After the installation is complete, the kit contents are available at:

<Install directory>\ Solar-Powered IoT Device Kit
The default locations, for Windows 7, are:

64-bit: C:\Program Files (x86)\Cypress\ Solar-Powered IoT Device Kit
32-bit: C:\Program Files\Cypress\ Solar-Powered loT Device Kit

3.2 Uninstalling Software

To uninstall the Solar-Powered loT Device Kit software, follow either of these methods (for Windows 7):

1. Goto Start > All Programs > Cypress > Cypress Update Manager; click the Uninstall button.

2. Go to Start > Control Panel > Programs and Features. Select the Solar-Powered I0oT Device Kit program from the
list and click Uninstall/Change.

3.3 Using PSoC® Creator™

PSoC Creator? is a state-of-the-art, easy-to-use integrated design environment (IDE). It is a revolutionary hardware and
software co-design environment, powered by a library of pre-verified and pre-characterized PSoC Components. With
PSoC Creator, you can:

®  Drag and drop PSoC Components to build a schematic of your custom design
B Automatically place and route components and configure GPIOs
®  Develop and debug firmware using the included component APIs

PSoC Creator also enables you to tap into an entire tool ecosystem with integrated compiler chains and production
programmers for PSoC devices.

Download the latest version from www.cypress.com/psoccreator.

For sample firmware information for this kit, see 6 Example Project.

210 develop firmware for the Solar-Powered 0T Device Kit, PSoC Creator 3.2 SP1 or newer version is required.

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 11
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4  Getting Started

This section explains how to establish a connection between the Energy Harvesting Motherboard operating as a WSN and
a PC with the BLE-USB Bridge. The connection confirms whether the Motherboard, BLE-USB Bridge, and the PC operate

properly.

4.1 Solar-Powered BLE Beacon Operation

Establish a BLE connection to confirm that the Motherboard the BLE-USB Bridge operate properly. The motherboard
contains all components of WSN, including:

B Energy harvesting PMIC S6AE101A

®  Capacitors for energy storage

B An EZ-BLE PRoC module for transmitting data

B An [2C temperature and humidity sensor

A USB to serial device is also included in the Motherboard to allow you to configure parameters such as the ID into the EZ-
BLE module from a PC application. The motherboard comes with pre-loaded firmware to operate as a BLE Beacon. By
connecting the Solar Module to the Motherboard and exposing the Solar Module to ambient light; the motherboard will
power up and begin transmitting.

The BLE-USB Bridge is pre-configured to look for the transmission from the Motherboard operating as a BLE Beacon. By
installing the BLE-USB Bridge on a Windows PC and using the provided software, you will be able to detect the Motherboard,
and determine the distance between the Motherboard and the PC using BLE.

4.1.1 Installing USB Driver of BLE-USB Bridge

Follow these steps to install the USB driver of the BLE-USB Bridge:
1. Plugin the BLE-USB Bridge into your computer's USB port.

2. The driver installation starts automatically and the following message window will appear. Click the message window
for status.

:J Installing device driver software

Click here for status.

FBAREPS DT .

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 12
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Getting Started

Confirm that the device driver installation has successfully completed (all components will be "Ready to use"). If the

installation fails, proceed with the manual installation using the driver files in the USB drivers folder. See 4.1.2 USB

Device driver software was not successfully installed

KitProg USBUART XNU driver found

What can [ do if my device did not install properly?

3.
Driver Installation Failure.

Your device is ready to use

USB Composite Device + Ready to use

USB Input Device + Ready to use

KitProg USB-UART (COM142) + Ready to use

KitProg (1.2.3.3) + Ready to use

Figure 4-1. Installation Complete

4.

a. Open the Device Manager:

Windows 7: Start > Control Panel > Device Manager
Windows 8/8.1/10: Right-click Start > Device Manager

Figure 4-2. Installation Failure

After the successful installation of the device driver, check whether a new COM port KitProg USB-UART was added:

b. Under Ports (COM & LPT), check whether a COM port KitProg USB-UART was added. Note the COM number

(COMXxXx).

==

m| B | &

& Comnputer

1 Disk drives

W% Display adapters

05 Human Interface Devices
@ IDE ATA/ATAPL controllers
2 Imaging devices

— Keyboards

] Memory technology driver
F Mice and other pointing devices
ﬁ Monitors

& Network adapters

Il Other devices

YT Ports (COM & LPT)

" Intel(R) Active Management Technology - SOL (COM3)

| 7 kitProg UsB-UART (COM138) |
B Processors

P Security Devices
& Sound, video and game controllers
& System devices

W Universal Serial Bus controllers

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 13
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Getting Started

4.1.2 USB Driver Installation Failure

Follow these steps if the USB driver installation fails:

1. After the successful installation of the device driver, check whether a new COM port KitProg USB-UART was added:

a. Open the Device Manager:
Windows 7: Start > Control Panel > Device Manager
Windows 8/8.1/10: Right-click Start > Device Manager

b. Under Ports (COM & LPT), check whether a COM port KitProg USB-UART was added. Note the COM number

(COMxx).

File Action View Help
e @ Hmle

1> EJ] Memory technology driver B
> ¥ Mice and other pointing devices
» & Monitors
4 ¥ Network adapters
- I_-'f Bluetooth Device (Personal Area Network)
l,-'f’ Bluetooth Device (RFCOMM Protocol TDI)
¥ Cisco Systems VPN Adapter for 64-bit Windows
¥ Intel(R) Dual Band Wireless-AC 7260
¥ Intel(R) Ethernet Connection 1218-LM
¥ Microsoft Virtual WiFi Miniport Adapter

4 |5 Other devices
|i& PCI Simple Communications Controller
4 "5 Ports (COM & LPT)
Y Intel(R) Active Management Technology - SOL (COM3)
> n Processors.
> |J¥ Security Devices
4 ~9’ Sound, video and game controllers
1> - System devices
b B Universal Serial Bus controllers =

2. Update the USB driver software or the unconfigured KitProg USB-UART.
a. Right-click KitProg USB-UART.
b. Select Update Driver Software...

3. Select Browse my computer for driver software.

How do you want to search for driver software?

2 Search automatically for updated driver software
Windows will search your computer and the Internet for the latest driver
software for your device, unless you've disabled this feature in your device
installation settings.

= Browse my computer for driver software
Locate and install driver software manually.

Cancel

4. Search for USB driver in the USB drivers folder.
a. Selectthe Include subfolders option.
b. Click Browse.
c. Select the USB drivers folder in the kit files.
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d. Click OK.
e. Click Next.

Browse For Folder u

Browse for driver software on your computer Select the folder that contains drivers for your hardware.
b
Search for driver software in this location: c
. 1 -~
sers\efukawa\Desktop\CTW\EH Workshop\Labs\USB drivers g | USB drivers
4 | drivers
Include subfolders
- ). DVK Prog s
| DVK_Prog5
J. DVKProgl
b ft ‘
< Let me pick from a list of device drivers on my computer [ L f1k3 | |
This list will show installed driver software compatible with the device, and all |
driver software in the same category as the device. Folder: USB drivers d
|[ oK l [ Cancel

5. The installation of the USB driver begins. Click Close when the driver installation of the KitProg USB-UART finishes.

Installing driver software... Windows has successfully updated your driver software

S =
L Windows has finished installing the driver software for this device:

KitProg USB-UART

‘ﬁ
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6. After the successful installation of the device driver, check whether a new COM port KitProg USB-UART was added:

a. Open the Device Manager:

b. Under Ports (COM & LPT), check whether a COM port KitProg USB-UART was added. Note the COM number

(COMXxXx).

flle Action View Help
ew|m Hml M

i Computer

e Dk drives

G, Display adapters

05 Human Interface Devices
Cail IDE ATASATAPI contrgllers
%]rﬂaging devices

= Keyboards

r] Memony technology driver
A Mice and ather pointing devices
K manitar

¥ Network adapters

| Other devices

¥ Pots (COM & LPT)

IEMMMWIDQ\« - S0L (COM3)
" KitProg USE-UART (COM138)

Bl Processons

o Security Deviead

{5 Sound, wideo and game controllers
i System devices

¥ Universal Serial Bus controllers

4.1.3 Installing USB Driver for Motherboard

Follow these steps to install the USB driver for the Motherboard:

1. Run CypressDriverinstaller.exe, the installer for the USB serial device on the Motherboard. You can find the installer

at <Install directory>/Solar-Powered IoT Device Kit/1.0/USB drivers.

>

Name Date modified
| drivers 6/16/2015 7:05 PM
"Rr' CypressDriverlnstaller.exe 6/4/2015 11:26 AM

2. Click Next to continue.

Cypress USB-Serial Driver Installer

This wizard will guide you through the installation of
Cypress USB-Serial Driver.

It is recommended that you close all other applications
before starting Setup. This will make it possible to update
relevant system files without having to reboot your
computer.

Click Next to continue.
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3. Read the license agreement and click | Agree.

* Windows Driver Installer for USB-Serial Device:

License Agreement

Please review the license terms before installing Cypress
USB-Serial Driver.

Press Page Down to see the rest of the agreement.

FYPRESS SOFTWARE LICENSE AGREEMENT -

This document is a legal agreement (the
"Agreement") between you ("Licensee")

and Cypress Semiconductor Corporation

("Cypress"). Cypress design and

development tools include software (the

"Technical Package") that may be

distributed on CD-ROM, through the internet, as -

If you accept the terms of the agreement, click I Agree to continue. You must accept the
agreement to install Cypress USB-Serial Driver.

MNullsoft Install System v2.46

[ <Back | 1agee | [ concel |

4. To install the driver at the default location, click Install. To change the Destination Folder, click Browse and choose a
folder.

Choose Install Location
Choose the folder in which to install Cypress USB-Serial Driver.

Setup will install Cypress USB-Serial Driver in the following folder. To install in a different
folder, dlick Browse and select another folder. Click Install to start the installation.

Destination Folder

C:¥Program Files (x86)¥ Cypress¥ Cypress USB-Serial Driver

Space required: 23.5MB
Space available: 299.3GB

Nullsoft Install System v2.46

<Back | mstall | [ concel
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5. The installation of the USB driver begins. Click Close when the driver installation of the Motherboard finishes.
& Windows Driver Installer for USB-Serial Devices | IES = TImE S

Cypress USB-Serial Driver Installer

“r Windows Driver Installer for USB-Serial Devices

Installing

Please wait while Cypress USB-Serial Driver is being installed.

Cypress USB-Serial Driver Installer utility has installed the

Extract: cyusb3.sys... 100%
ract: cyusb3.sys. USB Serial Windows Drivers Successfully.

< Back Mext > Cancel

6. Configure the Motherboard to receive power from the USB port. Change jumper J4 to "USB" from "EH".”

7. Connect the Motherboard to your computer using a USB cable.

USB Cable

8. The driver installation starts automatically and the following message window will appear. Click the message window
for status.

[ ! Installing device driver software * *
Click here for status.
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9. Confirm that the device driver installation has successfully completed (all components will be Ready to use).

J Driver Software Installatiol E

Your device is ready to use

USB-Serial Composite Device / Ready to use
USB-Serial Adapter / Ready to use
USB-UART LP Vendor MFG / Ready to use
USB Serial Port (COM139) / Ready to use

10. After the successful installation of the device driver, check whaher a new COM port KitProg USB-UART was added:
a. Open the Device Manager:

b. Under Ports (COM & LPT), check whether a COM port KitProg USB-UART was added. Note the COM number
(COMXxx).

11. Finally, disconnect the USB cable, then reset the jumper J4 set in step 6 back to "EH" from "USB" to supply power from
the Solar Module.

4.1.4 Establishing BLE Connection
Follow these steps to establish a BLE connection:

1. Connect the Solar Module (AM-1801, included in the kit) to the Energy Harvesting Motherboard. Plug the black wire
(negative) to J1-6 and the red wire (positive) to J1-5 as shown below.

J2 N

Note that J1-1

to J1-4 and J1-

7 to J1-10 are
unused

2. Place the Motherboard with Solar Module under an office light. The firmware to operate the Motherboard as a BLE
Beacon is pre-loaded from the factory. After attaching the Solar Module and placing the Motherboard under a suitable
light level (see Table 4-1), it will automatically power up and begin transmitting.

N
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Typical Light Level Environment Time Interval of Beacon?

~11Ix Moonlight Does not work

50 Ix~100 Ix Under street lighting Does not work

200 Ix~400 Ix At Museum 1.0 sec ~ 5.0 sec

400 Ix~500 Ix Office lighting 0.6 sec ~ 1.0 sec

1000 Ix Shopping mall, Rainy day 0.4 sec ~ 0.6 sec

Table 4-1. Light Level versus Time Interval
3. Plugin the BLE-USB Bridge to your computer's USB port.
4. Run PMIC.exe, which is the Windows application used to view data received from the Motherboard. You can find the
exe in the installation directory: <Install directory>/Solar-Powered |oT Device Kit/1.0/PMIC Software.

5. In the Port setting dialog, select KitProg USB-UART (COMxx) from the Port #1 drop-down list, where COMxx

corresponds to the port that was confirmed in step 5. Retain the Specific Device # as Don’t care. Click OK.

Port #1

niz <
SpeTTC BEVICS #
@ Don't care

X : ! Specific #

6. Find the MAJOR number of the Motherboard on the PMIC Software (see 4.3 Serial Command List). Then, move the
Motherboard away from your computer. The Received Signal Strength Indicator (RSSI) value will change and the

graphic will be updated.

Do

File View Help

Distance [m]

ID: 1
RSSI: =35

File View Help

Distance [m]

Far (About 5m)
——

3 The initial setting of time interval is set 1.5 sec. You need to configure an ITRVL command to change time interval. See 4.3 Serial

Command List.
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4.1.5 Vibration Energies Connection (Optional)

The Energy Harvesting Motherboard receives AC voltage from piezoelectric or electro-magnetic Energy Harvesting
Devices (EHDs) that harvest vibration energy. To confirm this operation, a piezoelectric or electro-magnetic EHD is

required (not supplied with Kit). To check the vibration energies connection:

1. Connect the piezoelectric or electro-magnetic EHD to the Motherboard. Plug the wires from the EHD to J1-3 and J1-4

as shown below. Note that there is no polarity.

Note that J1-1

to J1-2 and J1-

5t0J1-10 are
unused

Weight Piezoelectric

Non polarity

2. Move the EHD to generate vibration energy.

3. Follow steps 3 to 5 in 4.1.4 Establishing BLE Connection to confirm that the Energy Harvesting Motherboard is
operating. Figure 4-3 is sample waveform for the operation of vibration energies. If the Motherboard is not operating,

you may have to increase the vibration energy. See the documentation for the EHD being used.

!

L
(o1 ) 2.0v/div 1MQ By:20.0Mm NGYEAL

(o4 ) 5.0mA/div 1MQ By:120M

Stopped
1acqs RL:50.0k
Auto

500ms 10.0kSis 100ps/pt

Figure 4-3. Sample Waveform for Operation of Vibration Energies
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4.2 Solar-Powered Wireless Sensor Node (WSN) with BLE Beacon

In this section, you will configure the Motherboard as a WSN by turning ON the temperature and humidity sensor. You will
use a serial USB connection from your PC to send configuration commands to the Motherboard.

You will also check if the Motherboard is operating as a WSN by using the provided software on your PC to detect
temperature and humidity changes.

4.2.1 Configuring Motherboard as a WSN

Follow these steps to configure the Motherboard as a WSN:

1. Configure the Motherboard to receive power from the USB port by changing jumper J4 to "USB" from "EH".

2. Connect the Energy Harvesting Motherboard to your computer using a USB cable.

3. Confirm that a COM port (USB Serial Port) was added in the Windows Device Manager:

a. Open the Device Manager:
b. Under Ports (COM & LPT), check whether a USB Serial port was added. Note the COM number (COMxx).

4. Install Tera Term from the following location: <Install directory>/Solar-Powered IoT Device Kit/1.0/PMIC
Software/teraterm.

5. After installing, run Tera Term:
[0 Windows 7: Start > All Programs > Tera Term
0 Windows 8/8.1: Ctrl + Tab keys > All Apps > Tera Term
0 Windows 10: Start > All Apps > Tera Term
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6. In Tera Term, follow the menu path File > New Connection. In the New Connection window, select the Serial option
and select COMxxx: USB Serial Port(COMxxx) from the Port drop-down list. Click OK.

Tera Term: New connectio X

O TCP/IP

@ Serial

~ myhost.example.com -

History =
Service: © Telnet TOP port
@ SSH SSH version: |SSH2

Other

4

Protocol: |[UNSPEC

1

Port: COM139: USB Serial Port (COM1:

4
b

l OK l l Cancel ] l Help l

7. Follow the menu path Setup > Terminal and configure the following terminal settings and click OK:

0 Receive: AUTO

O  Transmit: CR+LF

0 Local echo: Check

[0 Other settings: Default

Terminal size
80 X

V] Term size =
Auto window resize

New-line
24 Receive: |AUTO ~

win size ITransmit: CR+LF vI Cancel

Help

Terminal ID: IVT100 ']

Local echo

Answerback

Kanji (receive)

[[] Auto switch (VT<->TEK)

Kanji (transmit)

UTF-8 ~ Kaniji-in: N$B ~

7bit katakana 7bit katakana Kanji-out: AB ~
locale: CodePage: 932
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8. Follow the menu path Setup > Serial Port. In the Serial Port setup window, set the Baud rate to 115200. Click OK.

Tera Term: Serial port s_ -

Port: COM139 -~ OK
Baud rate: 115200 ~

Data: 8bit v Cancel
Parity: ‘none "

Stop: Mbit o~ Help
Flow control: none -

Transmit delay
0  msec/char 0  msec/line

9. Enable the sensor on the Motherboard by placing the Motherboard into command mode and sending a command to

the Motherboard from the PC.

a. Push and release the XRES button on the Motherboard. Note that when the Motherboard is in the command mode,
it stops transmitting BLE WSN data.

b. Check whether the message “Start....” Appears on Tera Term. This confirms that the Motherboard is in the
command mode and is ready to receive commands.
c. On Tera Term, type “sensor on” and press Enter. The Motherboard responds with a confirmation message as
shown below. See 4.3 Serial Command List for a list of all commands.

File | Edit | Setup Control Win
p o I.i.

-~ COM138:115200baud - Tera Term EI _

dow Help
will ta
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d. To leave the command waiting mode, type “exit” and press Enter. The board will acknowledge the command by

responding with an “exit”. The board will retransmit the Bluetooth Beacon data.

- COM139:115200baud - Tera Term VT _

File | Edit | Setup Control Window Help
UART E tarting. [t will t:

10. Finally, disconnect the USB cable Then, reset the jumper J4 set in step 1 to "EH" from "USB" to supply power from the
Solar Module.

4.2.2 Validating WSN
Follow these steps to check whether WSN is operating:

1. Connect the BLE-USB Bridge to your computer's USB port.

2. Run PMIC.exe (<Install directory>/Solar-Powered IoT Device Kit/1.0/PMIC Software). In the Port setting dialog, select

KitProg USB-UART (COMxx) from the Port #1 drop-down list, where COMxx corresponds to the port that was
confirmed earlier. Retain the Specific Device # as Don’t care. Click OK.

Port #1

Q@ Don't care

© Specific #

3. Follow the menu path View > Mode and select either Humidity mode or TEMP mode.

T
File Help
¥ Grid

ID| Refresh data

-

Mode 4 TEMP mode
v | Humidity mode
Distance mode

80
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4. Place your finger on the sensor on the Motherboard. This raises the temperature and humidity from the indoor
environment condition. You should see a corresponding change in humidity or temperature on your PC. When touching
the board, be careful of static electricity.

File View Help

Humidity[%]

ID: 1

RSSI: -71

If you need to operate by vibration, see 4.1.5 Vibration Energies Connection (Optional).

4.3 Serial Command List

Touch the sensor

Table 4-2 lists the serial commands which can be used to control the kit from your computer using the USB serial interface.
See 4.2.1 Configuring Motherboard as a WSN for instructions on how to issue these commands via the USB serial interface.
The commands are case sensitive.

No. Commands Name Description Default
. " 00050001-0000-1000-

[1] uuID Read/Write of UUID 8000-00805F9B0131 [hex]

[2] MAJOR Read/Write of MAJOR* 0x0001
0x0001
(Note: Sensor data is sent

[3] MINOR Read/Write of MINOR* after it is overwritten in the
MINOR region when
SENSOR command is ON)

[4] TXPWR Read/Write of Transmitter Power Strength 3dBm

[5] RSSI Read/Write of Receiver Power Strength for distance 1m (RSSI) -61 dBm
1500 ms
(Note: Time interval is

[6] ITRVL Read/Write of Advertise Interval for Beacon fixed at six seconds when
the SENSOR command is
ON)
0x0131 (Cypress

[7] COID Read/Write of Bluetooth Company Semiconductor
Corporation)

[8] SENSOR Overwrite sensor information in MINOR packet region and send it OFF

9] ERASE Default parameters -

Finish the command waiting mode, and then retransmit the Bluetooth
[10] EXIT -
beacon data
[11] VER Display Firmware Version -

Table 4-2. Command List

4 See 6.3 BLE Beacon Process for detailed information.
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[1] Read/Write of UUID

[1-1] Read
Read UUID data. Default: 00050001-0000-1000-8000-00805F9B0131

Example
UUIDd
(echo) UuUID
(output) -> UUID: 00050001-0000-1000-8000-00805F9B0O131

[1-2] Write
Write UUID data.

Example
UUID EEEEDDDD-CCCC-BBBB-AAAA-999988887777<J
(echo) UUID EEEEDDDD-CCCC-BBBB-AAAA-999988887777
(output) -> New UUID: EEEEDDDD-CCCC-BBBB-AAAA-999988887777

[2] Read/Write of MAJOR

[2-1] Read
Read MAJOR. Default: 0x0001

Example
MAJOR<
(echo) MAJOR
(output) -> MAJOR: 0001

[2-2] Write
Write MAJOR.

Example
MAJOR 1A2F<J <- Input HEX data
(echo) MAJOR 1A2F
(output) -> New MAJOR: 1A2F

[3] Read/Write of MINOR

[3-1] Read
Read MINOR. Default: 0x0001

Example
MINOR<
(echo) MINOR
(output) -> MINOR: 0001

[3-2] Write
Write MINOR.

Example
MINOR 2C3DJ <- Input HEX data
(echo) MINOR 2C3D
(output) -> New MINOR: 2C3D

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B

27



o CYPRESS

~ggg»>” EMBEDDED IN TOMORROW™

Getting Started

[4] Read/Write of Transmitter Power Strength

[4-1] Read
Read Power Strength. Default: 3 dBm

Example
TXPWR<I
(echo) TXPWR
(output) -> TX power in dBm: 3

[4-2] Write
Set Power Strength. Set Value: -18, -12, -6, -3, -2, -1, 0, 3

Example
TXPWR -18¢J
(echo) TXPWR -18
(output) -> New TX power in dBm: -18

[5] Read/Write of Receiver Power Strength for distance 1m (RSSI)

[5-1] Read
Read RSSI. Default: -61dBm

Example
RSSI
(echo) RSSI
(output) -> RSSI in dBm: -61

[5-2] Write
Set RSSI.

Example
RSSI -90&J
(echo) RSSI -90
(output) -> New RSSI in dBm: -90

[6] Read/Write of Advertise Interval

[6-1] Read
Read Advertise Interval. Default: 1500ms

Example
ITRVL
(echo) ITRVL
(output) -> Advertise Interval in msec: 1500

[6-2] Write
Set Advertise Interval. Set Value: 100~10240 ms

Example
ITRVL 102400
(echo) ITRVL 10240
(output) -> New Advertise Interval in msec: 10240
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[7] Read/Write of Bluetooth Company

[7-1] Read

Read Bluetooth Company. Default: 0x0131 (Cypress Semiconductor Corporation)

Example
coipd
(echo) COID
(output) -> Company ID: 0059

[7-2] Write
Write Bluetooth Company.

Example
COID 004Ccd <- Input HEX data
(echo) COID 004cC
(output) -> New Company ID: 004C

[8] Read/Write of sensor setting

[8-1] Read
Read sensor setting Default: OFF

Example
SENSOR
(echo) SENSOR
(output) -> Sensor mode: OFF

[8-2] Write
Change sensor setting set value: ON or OFF

Example
SENSOR ON<J
(echo) SENSOR ON

(output) -> New Sensor mode: ON
[9]1 ERASE
Erase the flash memory in MCU. After erase, all value will be default parameters.
Example

ERASEJ

(echo) ERASE
(output) Erase completed!

[10] EXIT
Finish the command waiting mode, and then retransmit the Bluetooth beacon data.

Example
EXITI
(echo) EXIT
(output) ---
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[11] VER
Display Firmware Version.

Example
VER
(echo) VER
(output) -> S6SAE101A00SA1002 Sample Firmware, Version 1.0

[*] Input another command (Error Handling)
TEST

(echo) TEST

(output) Command format error!!
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The Solar-Powered IoT Device Kit can be programmed using UART Bootloader, and it can be programmed and debugged
using PSoC Creater with MiniProg3. Before debugging the device, ensure that PSoC Creator is installed on the computer.

5.1 UART Bootloader (Program Only)

An UART Bootloader makes it possible for a product's firmware to be updated in the field. Bootloading is a process that
allows you to upgrade your system firmware over UART. The UART Bootloader communicates with a host to get new
application code or data, and writes it into the device's flash memory.

1. Configure the Motherboard to receive power from the USB port. Change jumper J4 to "USB" from "EH".

2. Connect the Energy Harvesting Motherboard to your computer using a USB cable.

USB Cable

3. Confirm that a COM port called USB Serial Port was added:

a. Open the Device Manager:
b. Under Ports (COM & LPT), check whether a COM port USB Serial Port was added. Note the COM number
(COMxXx).

4. Run UARTBootloaderHost.exe from the installation directory: <lInstall directory>\Solar-Powered 10T Device
Kit\1.0\PMIC Software.
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o=/ UART Bootl

Step 1: Select COM Port and Baud Rate

Step 2: Select a Bootloadable File and Click Bootload

W
Status Log
UARTBootloa ’ B

derHost.

5. Select USB serial port where COMxx corresponds to the port that was confirmed in step 3. Select 115200 as the Baud
Rate.

- UART Bootloader Host Applicatio =

Step 1: Select COM Port and Baud Rate
Step 2: Select Miile and Click Bootload

Bootload

Browse

Status Log

o' UART Bootloader Host Applicatio =

Step 1: Select COM Port and Baud Rate

Select GOM Port [comize v | Baud Rate [:]

600

Step 2: Select a Bootloadable File and Clicl | 3500

Browse

6. Click Browse and select LED_ONOFF.cyacd from <Install directory>/Solar-Powered loT Device Kit/1.0/PMIC
Software/Bootloader_Host_GUI_exe.

a-' UART Bootloader Host Applicatio =

Step 1: Select COM Port and Baud Rate

Select COM Port |COM 38 ¥ | Baud Rate [115200 -

Step 2: Select a Bootloadable File and Click Bootload

Status Log

Status Log

Browse
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4./ Open CYACD File

I . Picsotvme » oo v cviers 1y | sz o)
Organize ¥ New folder - 0O @
4 - Favorites = Name : Date modified Type
B Desktop EH_Motherboard.cyacd 7/9/2015 6:43 PM CYACD Fil
4 Downloads = 7/10/2015 226 PM  CYACD Fil

<» Recent Places

4] Libraries

[» [*, Documents

& . Music
[> &, Pictures
[> !, Videos
4 & Compuiter adfaf i | ’
File name: *cyacd - [cyacd file (*.cyacd) 'l
l Open I [ Cancel ]

If you have already developed your own firmware using PSoC Creator, the .cyacd file is generated in the project folder:
[PSoC Creator Project Folder])/CortexMO/ARM_GCC_484/Debug (or Release).

7. Press the XRES button on the Energy Harvesting Motherboard, and then click Bootload in the UART Bootloader Host
Application dialog.

a-' UART Bootloader

Step 1: Select COM Port and Baud Rate

Select COM Port |COMI 39 ¥ | Baud Rate |115200 -

Step 2: Select a Bootloadable File and Click Bootload

G ¥l sers¥efukaway Desktop¥document¥GUIY¥ Bootloader Host_GL
=

Status Log

A "Bootload Started at X:XX:XX" message will appear in the Status Log window, and then an indicator will advance.

a- UART Bootloader

Step 1: Select COM Port and Baud Rate

Select COM Port COMT 39 ¥ | Baud Rate 115200 v

Step 2: Select a Bootloadable File and Click Bootload
C ¥ UsersYefukawa¥ Deskiop¥do cument¥GUI¥Bootloader Host_GL Browse

Bootload
Status Log

| Eootioad Started at 5:33:20 P | -

%
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The programing is completed when a "Bootload in successful I!" message appears in the Status Log window.

©

Disconnect and re-connect the USB cable, and then the status LED will blink at 1 sec interval. This sample firmware
only supports LED blinking control as a demonstration (See A.1 LED ONOFF Project for detailed information),
therefore, reprogram the EH_Motherboard.cyacd in the Bootloader_Host_GUI_exe folder to restore the BLE Beacon
operation (See steps 4 to 7 above).

5.2 PSoC Creator with MiniProg3 (Program and Debug)

The MiniProg3® (not included in this kit) is the hardware/firmware block for onboard programming, debugging, and bridge
functionality. It is a common reusable hardware/firmware block used across many Cypress kit platforms. The MiniProg3
communicates with PSoC Creator software to program/debug the target EZ-BLE PRoC Module over the SWD interface.

The following are the requirements for the preparation of program and debug:
B  Energy Harvesting Motherboard

®  MiniProg3 Program and Debug Kit> (Not included in this kit)

®  Windows PC for Programing and Debug

®  PSoC Creator 3.2 SP1 or newer®

5.2.1 Program
Follow these steps to program the firmware:
Disconnect USB cable from the Energy Harvesting Motherboard.

1. Setthe J4 jumper socket to "EH" to supply the power from MiniProg3. A protection diode is mounted between the Solar
Module and the S6AE101A, therefore, it is not necessary to remove the solar module when using the MiniProg3.

2. Connect the MiniProg3 to the Energy Harvesting Motherboard and your computer as shown below.

5 To debug this board, a MiniProg3 Program and Debug Kit is required.

6 The kit does not support PSoC Creator 3.2 or older. It needs to update PSoC Creator when you are using the 3.2 or older.

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 34


http://www.cypress.com/?rID=38154

W & CYPRESS

EMBEDDED IN TOMORROW™ Program and Debug

3. Open the sample project EH_Motherboard.cypj for this kit from <Install directory>/Solar-Powered 10T Device
Kit/1.0/Firmware/EH_Motherboard/EH_Motherboard.cydsn.

File Edit View Project Build Debug Iools Window Help
MNSESddd 4 G2l X ’M"Debug |
[he 39,
| Workspace Explorer (2 projects)  ~ # X Start Page | vabx
B8
& Workspace 'EH_Motherboard (2 Pr | PSoC® Creator™
=1 %3] Project ‘EH_Motherboard' [CYI
i TopDesign.cysch g
#® EH_Motherboard.cydwr H 2
512 Header Files £/ IRecentProjects
2 ConfigRW.h 53| EHMothertoard cyprj
B maiak LED, CNGFF oypr] PSoC Creator News and Information
) Si7020h 23] LED ONOFF oyprj Getting Started Apolication Notes to gl
1) UsrtCmd.h & B3] LED. ONCFF oypr Learn about PSoC Technology epteaty
) WriteUserSFlash.h BLELER B ok Posted on 06202015 Campone
o4 = ‘Are you new to Programmable System-on-Chip
i ;"‘é’o‘:if”ssw . B Creata New Prokct (PSoC) technology? PSeC Is similar 1o ofer Desgnc
9! H Ogen Exsting Proct. _ || MCUs, but have important acvantages. PSoC
3\ fs";‘o"zé || faciltates rapid prototypmg and fast
4 Si7020¢ development as well as optimzed PCB layouts.
@ UanCmd.c Géting Started Walso enables system-level design decisions in '/
@ WriteUserSFlash.c PSof Creator Start Page fimware 3nd digita and analog ha.
473 Project "UART_Bootioader’ [CYBI %&f‘;‘;“’e Read More
£ TopDesign.cysch Itro to PSoC Crestor
{? UART_Bootloader.cydwr PSoC Greator Trairirg The New Cypress com Beta Website is
=13 Header Files Design Tutorials. Avaiable for Preview
1) deviceh Getting Started With PSoC 3 Pos 0 062N2015
4@ Source Files Getting Started Vith PSoC 4 oy ==
& mainc Ceiuciail hpton The Cypress teamis pleased o announce that we ve
#ting Starthd it PSoC been warking 1o develop a new Cypress com website
Getting Started with PRoC B. and forum The beta release is being made avatadle
to allow you to test and evaluate the new site beforewe  Check out our new
Examples and Kits launch t1o the world. The new siteis not [
% » recommended for placing orders, Sl
P s Bt Read More ite
o i s
Nowles
Product ~ || i v
Output A%
Show output from: All - %
Log file for this session is located at: C:\Users\efukawa\AppData\Local\Temp\PS -
« m B
« m » |= | Output | Notice List
Ready 2 Errors

4. Follow the menu path Build > Clean and Build All Projects. The build status will appear on lower right side of PSoC

Creator. The build process complete when the "Rebuild succeeded" appears on message window.

File Ef View Project | Build | Debug Tools Window Help
B 5 & @ & 4|25 Build All Projects F6 =
BB .‘g Em )& ﬁ _ Clean All Projects

Workspace Explorer (2 projef 5 Clean and Build All Projects E Digital I 2 Errars 1 Warnings 0 Notes l

s | Build EH_Motherboard  Shift+F6
& Workspace 'EH_Motherbo

2] Project 'EH_Motherbd

Clean EH_Motherboard

—
& TopDesigncysch |4 Clean and Build EH_Motherboard
#P EH_Motherboard.cy pa
EB Header Files - B Ct M Show output from: Al =3
+[n] ConfigRW.h arm-none-eabi-gcc.exe -Wl,--start-group -o .\CortexMO\ARM GCC_484\Debug\EH Moth a
[m] main.h Al Compile File Ctrl+F6 PSoC Creatol cyelftool.exe -B C:\Users\efukawa\Desktop\EH Motherboard\EH Motherboard.cydsn\C
Si7020h cyelftool.exe -5 C:\Users\efukawa\Desktop\EH Motherboard\EH Motherboard.cydsn\C
[ si - % Generate Application Getting Starfe Flash used: 87040 of 131072 bytes (66.4 %). Bootloader: 3968 bytes. Application
(0] UartCmd.h = Learn about | SRAM used: 98 . Heap: 128 bytes.
“.[F] WriteUserSFlash.{ & Generate Project Datasheet Fosted on 06/30% | | —==---==-=-== -I- Rebuild Succeeded: 07/10/2015 22:27:00 —-I- ————————————
BB Source Files = Are you new to | =
8] ConfigRW.c g v Brctne P (paocytechndl | |« ’
: ; ‘ = Fen Bxisting Project _ || mcus, but have
»+[€] main.c = || facilitates rapid
Pl coanan - . . .
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5. Follow the menu path Debug > Program. If the Select Debug Target window opens, click Port Setting.

Eile Edit View Project Build | Debug | Tools Window Help

Select Debug Targe

%" MiniProg3/1430DD000042 MiniProg3/1430DD000042

s oy m——r . POWER = 3
ENSEEHad Sl & 2l | Windows ' WOLTAGE_ADC = 3480
. S FREGIUENGY = 1600000
B 2B R K Frogram s Ili CONNESTOR =10

Workspace Explorer (2 projects)  ~| 3% Select Debug Target... FROTEOEL = 23D

) #| Debuc 5

MiniProg3 version 2.05 [3.08/2.08]
Workspace 'EH_Motherboard’ (08
E+Pz| Project 'EH_Motherboard' [/ |

~
It

&' TopDesign.cysch |5k Attach to Running Target..
~#P EH_Motherboard.cydwr B
=+ Header Files ] @ Toggle Breakpoint ]
g E;;?:ERW‘h 1 New Breakpoint 3
(7 Si7020h D Delete A Ctrlsshiftsrg [9
+[n] UartCmd.h g
|n] WriteUserSFlash.h All Brea E - - .
545 Source Files R ——— € lShUW all targets ] | Port Setting | l Part Acouire I
i-[g] ConfigRW. 2 o -
e R o
6. 7. Inthe pop-up window, set the following:
OO0 Active Protocol = SWD
[0 Clock Speed =1.6 MHz
OO0 Power=33V
0 Acquire Mode = Reset
0 Connector =10 pin
Click OK.

e
IActi\.re Protocol: [SWD v

Clock Speed: |16 MHz A

Power

I OK I | Cancel I
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7. Click Port Acquire. PRoC BLE CYBLE-022001-00 appears in the Select Debug Target window.

%" MiniProg3/1430DD000042 MiniProg3/1430DD000042
POWER = 3

WOLTAGE ADC = 3480
FREQIUENCY = 1600000
COMNECTOR 19 =5 MiniProg3/1430DD000042 PRoC BLE CYB
PRoC BLE (ARM
Silicon ID: 0x0BB
Cypress D0 Ox0E
Revigion: PRODIL!

MiniProg3 version 2.05 [3.08/2.08]

Target unacouired

Show all targets '] ’ Port Setting ]l Paort Acquire l

8. Click Connect, and then click OK.

=3 MiniProg3/1430DD000042 PRoC BLE CYBLE-022001-00

PRoC BLE (ARM CMO)
Silicon ID: Ox0BBE11477
Cypress [D: OxOEBO0115E
Rewvision: PRODUCTICN

Target unacouired

Show all targets S ‘

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 37



A
W

9.

CYPRESS

EMBEDDED IN TOMORROW™

Program and Debug

appears once programming completes.

A "Programming - XXX of 1024 blocks" message will appear on lower left side of PSoC Creator, and then "Ready"

| EH_Mo -] x
FEile Edit View Project Build Debug Tools Window Help
DONdSFHdddd X g5 W& M- Debug
i 39 . Microsoft SansSerit =10 - B 7 @ [E|EE A-uf-Be %G8 .
| Workspace Explorer (2 projects)  » # ¥ Start Pe TopDesign.cysch 4 x |0
§
I8 Workspace EH_Motherboard' (2 Prl ", El
= ¥l Project "EH_Motherboard’ IC\’IE o E .
= £ QOutput | Nofice Li
1 EH. Motherboard cycwr - i | | (4 l utpu otice Lis|
£ Hester s illg BLE UART Interface HEN p
1 ConfighW.h o)\ BLE Cﬁmm;:;lsdcur;‘!::umd?s';:euwn in UART itertace o USE serial device - =
i non-connéctable advertisement mode: L i g _
5, El || SR, - ] Programming - 505 of 1024 blocks |
8 UartCmdh 4 L BE 3
) WriteUserSFlash El e H
4@ Source Fics i 2
&) ConfighW.c e
& mainc g e
& §i7020c .
4 tnonac Watch Dog Timer 12C Interface
&) WiteUserSFlash ¢
13 Generated_Source m"“’“"g"”” i usnd for waking up the system 12C Interface to the temperature/humidity
53l Project 'UART Bootioager [CYB] ‘en the 3ysis low power mode, -
o
Bootloadable 1/0 Interface
The Baotloadable companant links the USB_Detect pin is used to gat USE connector
‘apphcation to the Bootlaader projects hex status.
file P Debug_1 pin could oulput certain information for P
e hsadet debug purpose (f enabled — . 3
-"—’ T » |~ |Output | Notice Lis
b CwsaB e @bt P -
Ready I
EH_Matherboard ar
Output - ox
Show output from; Al - &
Log file for this session is located at: C:\Users\efukawa\hppData\local\Temp\PSol Creffto: -
i + [* [ output [ o Lt
lnmy _.

5.2.2 Debug

The sample project for this kit uses a bootloadable component for a UART Boot Loader. In the PSoC Creator bootloader
system, the bootloader project executes first (at device reset) and then the bootloadable project. The jump from the
bootloader to the bootloadable project is done through a software controlled device reset. This resets the debugger interface,
which means that the bootloadable project cannot be run in the debugger mode. To debug a bootloadable project, convert
the Application Type to Normal, debug it, and then convert it back to Bootloadable. Another option is to program the
Bootloadable project .hex file onto the device and then use the Attach to running target option for debugging, while the
bootloadable project is running. In this case, you can debug the bootloadable project only from the point where debugger is
attached to the device. See AN68272 for more details.

BLE

BLE Component is configured as a Beacon in
non-connectable advertisement mode
with no timeout (continuous transmission).

BLE
BLE

OBuetny

UART Interface

UART interface to USB serial device.

UART
UART

‘Standard

Watch Dog Timer

Watchdog timer is used for waking up the system
when the system is in low power mode.

12C Interface

12C Interface to the temperature/humidity

WDT_Imelrum
Bootloadable I/0O Interface

The Bootloadable component links the
application to the Bootloader project's .hex
file.

= Badtbadable:
Bootloadable

USB_Detect pin is used to get USB connector
status.

Debug_1 pin could output certain information for
debug purpose if enabled.

USB_Detect [¢i—— —{r Debug_1
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5.2.2.1 Converting Application Type to Normal

1. Open TopDesign.cysch.
File Edit View Project Build Debug Tools Window Help
BRSSPSR KB E X9 o ey -®Q M- Debug
-0 S 0|9 % & U Micos il cJio Bz uEEEA-L LNV EA= )
|Workspace Explorer (2 projects)  ~ 28X *TopDesign.cysch | Start Page -4vx|o
15 3
Workspace 'EH_Motherboard' (2 Pr 1 %
g ' card’ [CYE 3
.5 Hootr s &lo BLE UART Interface 2
8 e R e e U e U5 st v
[ 5i70201 = with no timeout (continuous transmission). UART 2
1 o
“-[n] WriteUserSFlash.h %
-6 Source Files = ©Bluetooth| =
£-c ConfigRW.c 4 - S
-2 main.c d
1.d) Si7020.c -
pdtamemae Watch Dog Timer 12C Interface
=) Generrla?sdses[ou?zss ‘ Watchdog timer is used for waking up the system |- 12C Interface to the temperature/humidity
2 Project "UART Bootloader’ [CYB Wwhen the system is in low power mode sensor.
—
2. Right-click the Bootloadable Component and select Disable.
BLE " wo JART
% Cut Ctrl+X I
BLE Compenent is configur| .
non-connectable advertisen = <oy Ctrl+C  (Tinterface to |
with no timeout (continuous 2 paste Cirla
BLE o [ uA
BLE | X Delete Del
OBluetoothl 5t Ctri+A S—
Zoom [ BT
Watch Dog  swee '12C Int Bootloadable
Watchdog timer is used for w Select * erface to the t The Bootloadable component links the
when the system is in low pa re acelothe l application to the Bootloader project's .hex
- ISIWDIT Configure... ’ . file. [E—
al nal
| Disable Bootloadable
WOT |
. Open Datasheet ... L
- - - - Find Example Project... —
Open Component Web Page
Bootload ° 1/0 Inte
The Bootloadable compon Lunen tane 2ct pin is used
application to the Bootload Generate Macro
file. . ) ) pin could outpt
Show in analog editor ‘pose if enable:
USB_Detect [si——0
3. Follow the menu path Build > Build All Projects to rebuild the projects.
#
File Edit View Project | Build | Debug Tools Window Help
BhasHdaan Build Al Projects F6 |3 - _ Debug

&5

Workspace 'EH_Motherbo

7P EH_Motherboard.cy

Workspace Explorer (2 projeq

EHEl Project "EH_Motherbg

21 Headar Filec

= Clean All Projects
#4| Clean and Build All Projects

Build EH_Motherboard Shift+F6
— Clean EH_Motherboard

Clean and Build EH_Motherboard

XA rancal Ruiild el Rraslk
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File Edit View Project Build | Debug | Tools Window Help

i B+ Header Files
~[1] ConfigRW.h

New Breakpoint

-] main.h
(1 Si7020.h ) Delete All Breakpoints  Ctrl+Shift+F9
- [n] UartCmd.h - )
- |r] WriteUserSFlash.h @ Enable All Breakpoints
| B> Source Files FH . | l
el ConfinRW - £

H0aEHda g2l Bl | Windows » bug _ 1
e
TR Nedl ¥ X Micro| % Program Cri+Fs E|A - #-a
=
Workspace Explorer (2 projects) - 3% Select Debug Target..
&5 Debug F5
Workspace 'EH_Motherboard' (2 f N 3
Project "EH_Motherboard" [C& Debug without Programming  Alt+F5
1) TopDesign.cysch 5 Attach to Running Target..
-~ EH_Motherboard.cydwr
/3 Toggle Breakpoint F9

lous transmis
BLE

After debugging, right-click the Bootloadable Component and select Enable. Rebuild and reprogram the project.

5.2.2.2 Using Attach to Running Target Option

1.

2.

BN a6l X

Open EH_Motherboard.cydwr, and then, go to the System tab.

File Edit View Project Build Debug Tools Window Help

9 055 v\‘L‘\'l& d4 - _ Debug = ]

(R 08 % 5 L
|Workspace Explorer (2 projects) ~ # %|
=)

& Workspace ‘EH_Motherboard’ (2 P
Pl Project ‘EH_Motherboard" [CY 9

20U

. ~[n) ConfigRW.h
8 mainh
(1) Si7020.h
(@) UartCmd.h
[ WriteUserSFlash h
£ Source Files
© (&) ConfigRW.c
+ le) mainc
 +[g) VarCmd.c
+ -[e) WriteUserSFlash.c
&+ Generated_Source
-fpa] Project 'UART Bootloader [CYE

sinsay | sweuseeq

~ Start Page  TopDesign.cysch * EH_Moth...rd.cydwr |

-4 b x

21-sMT

Alias  Name

\I2CM:sda\

P5[0] TCPWM3:line out,
BLESS:rfctrl extpa en,
SCBl:spi_select [0]

\UART:rx\

P1[4] OA3:vminus, TCPWN
SCBO:uart_rx, SCBO:iZc |
SCBO:spi_mosi

\UART:tx\

P1[S] OA3:vplus, TCPWMZ
scBO:uart_tx, SCBO:i2c |
SCBO:spi_miso

Debug_1

P3[7] SARMUX:pads[7], T
SCBl:uart cts, SR3S:exy

USB_Detect

P3[5] SARMUX:pads[5], 1
SCBliuart tx, SCBlii2c

<

“._4# Pins | "\ Analog (5 Clocks | # Interrupts | #» System | & Drectives &) Fiash Securty ar

Follow the menu path Debug > Debug. See Help > PSoC. For more information on using the debugger, see Help >
PSoC Creator Help Topics > Using the Debugger.

To debug, change Debug Select to SWD (serial wire debug). However, the consumption current will increase in SWD.
So, after debugging, make sure to select GPIO to restore the Solar-Powered operation.
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Start Page | TopDesign.cysch / EH_Moth...rd.cydwr |

= Reset T Expand | "z Collapse

*db X

= Configuration

Value

- Device Configuration Mode

Compressed

Unused Bonded IO

Allow but warn

- Heap Size (bytes)

0x80

Stack Size (bytes) 0x0800
- Include CMSIS Core Peripheral Library Files
2 Programming\Debugging
T = Chip Protection Open -
g GPIO -
El Operating Conditions
Variable VDDA —t
- VDD (V) 33
VDDR (V) 33

3.  Run the Program. See 5.2.1 Program.

4. Follow the menu path Debug > Attach to Running Target...

¥ EH_Motherboard -

A\ \EH_| ard _SP1 fCopy\EHfMoﬂletboard.cydm’

File Edit View Project Build Debug|100ls Window Help

5. Inthe Attach to Target window, click OK.

ENAEHA S 4 5l | Windows * bug -
S
-0 S E | B % Program Cirl+F5
"7
Workspace Explorer (2 projects) ~ {3 Select Debug Target... jth...rd.cydwr |
&) 1y # Debug F5
Workspace 'EH_Motherboard" (2 - - . SN -
& Fal Project 'EH_ Motherboard’ [Clo 40 thout Programming  Alt+F5
@' TopDesign.cysch Zk Attachto Running Target... II
(S EH_Motherboard.cydwr -
£+ Header Files J& Toggle Breakpoint F9
ﬂ &C;?:?]Rw'h New Breakpoint 3
[n] Si7020h | Delete All Breakpoints  Ctrl+Shift+F9
[0 UartCmd.h o
. [0 WriteUserSFlash.h “3] Enable All Breakpoints Fles
e+ Source Files | '
Attach to Target m

Dehbug:

Attached Targets:

Halt target on attach

I OK I [ Cancel
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6. The window of PSoC Creator is changed to Debug mode automatically. For more information on using the debugger,

see Help > PSoC Creator Help Topics > Using the Debugger.

L] Deboging - PSo Creator 3.2 CA.\CY BLE TEST\software\, EH BeaconiEH Beacon!PMIC JBeaconcydsnimaine] g

Ble Eot Yiew Poject Buld Debug Joos Window Help

e )

saax o B2y Debug

> uamn amed,
28X Topbesgn. - 41 x_Code Explorer (manc) = 4 x|
5 B e (2|11~

e | SEPIES | onos

~ % Call Stack

L v 1> Wioos B Hen

| Debugging - Hattes

7. After debugging, change Debug Select to GPIO. Rebuild and reprogram the project.
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6 Example Project

This chapter introduces you to the initial provided firmware of the Solar-Powered 10T Device Kit. This section discusses the
features such as the BLE Beacon Process and WSN with BLE Beacon Process. See Getting Started with EZ-BLE PRoC
Module for standard reference design except energy harvesting.

6.1 Flow Diagram

Figure 6-1 is the flow diagram for the example project of the kit firmware.

Enter Bootloader

Is USB
connection
detected?

N
A 4

Issue Software

Y-

Start UART
Bootloader and wait
for Bootload
command till
timeout

Command
received before
timeout?

Bootload over
USB-UART Com

Bootloadable

!

Perform Low Power
startup

Is USB
connection
detected?

N
A 4

SFLASH Parameter
Reading

Is SENSOR

reset to enter (&

[4————FEXIT command——

Start command
mode for changing
the parameters

flag ON?

N
A 4

Start WDT counter
for startup wait

|

Stop WDT counter

|

Start BLE

!

Put BLESS and
CPU to Deep sleep
(Continue
Advertisement )

A

Start BLE and 12C.
Start WDT counter
for 12C State
machine

'

Collect Humidity
and temperature

data and send it as 4
non—conn
advertising data

’

Put BLESS and
CPU to Deep sleep

|

Wakeup from WDT

interrupt

Figure 6-1. Flow of Example Project
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6.2 Function List

Table 6-1 lists the functions for the example project of the kit firmware.

Function Name

Description

CyDelay

Blocks for milliseconds

CyDelayUs

Blocks for microseconds

USB_Detect_Read

Reads the current value on the pins (P3.5) of the Digital Port in right
justified

UART_Start

Invokes SCB_Init() and SCB_Enable()

UART_UartPutString

Places a NULL terminated string in the transmit buffer to be sent at
the next available bus time

CyBtldr_Start

Starts the entire bootload operation

Bootloader_SET_RUN_TYPE

Schedules Bootloadable to start after reset

CySoftwareReset Forces a software reset of the device.
CySysClkWriteEcoDiv Sets the divider for ECO
CySysClkEcoStart Starts the External Crystal Oscillator (ECO)
CySysClkEcoStop Stops the megahertz crystal
WDT_Interrupt_StartEx Sets up the interrupt and enables
CySysClkWcoStart Enables Watch Crystal Oscillator (WCO)
CySysClkWcoSetPowerMode Sets the power mode for the 32 KHz WCO
CySysWdtLocked Reports the WDT lock state
CySysClkSetLfclkSource Sets the clock source for the LFCLK clock
CySysWdtEnable Enables the specified WDT counters

Locks out configuration changes to the Watchdog timer registers and
CysysWdtLock ILO configuration register
CySysWdtUnlock Unlocks the Watchdog Timer configuration register
CySysPmDeepSleep Puts the part into the Deep Sleep state
CySysWdtEnable Enables the specified WDT counters
CySysWdtDisable Disables the specified WDT counters

ConfigRW_CheckSFlash

Checks whether there is configuration data in User SFlash

cmd_uart_sub

Processes UART commands

CyBle_Start

Initializes the BLE Stack, which consists of the BLE Stack Manager,
BLE Controller, and BLE Host modules

CyBle_ProcessEvents

Checks the internal task queue in the BLE Stack, and pending
operation of the BLE Stack

CyBle_EnterLPM

Requests the underlying BLE modules such as BLE Controller, BLE
Host Stack, and BLE Stack manager to enter one of the supported
low power modes

CyEnterCriticalSection

Does not allow interrupts while entering system low power modes

CySysPmDeepSleep Puts the part into the Deep Sleep state
CySysClkWriteHfclkDirect Selects the direct source for the HFCLK
CySysClkImoStart Enables the IMO
CySysClkImoStop Disables the IMO
CySysPmSleep Puts the part into the Sleep state

Handles I2C events according to current state and update the state
ProcessI2CEvents

value

Handles Beacon events according to current state and update the
ProcessBeaconEvents

state value

S$i7020_Init

Initializes Temperature and Humidity sensor Si7020

S$i7020_WriteRead

Sends conversion command and read Temperature and Humidity
data

Beacon_GappStartAdvertisement

Starts the advertisement using the specified interval

CyBle_GappStopAdvertisement

Exits from discovery mode

Table 6-1. Function List
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6.3 BLE Beacon Process

This section explains the BLE Beacon Process in detail.

0. Complete BLE Beacon Process

The complete BLE Beacon process invokes Beacon_GappStartAdvertisement (). The waveform in Figure 6-2 shows the

BLE Advertisement states.

Power On

U

S6AE101A Output Voltage -

@- 1 ]
- 1 BLE BLE BLE
[ Advertisement  Advertisement Advertisem
- Bootloader Start and ‘ i : i : i 1
- Software Reset ‘ : : : . :

2 System Clock Setting E
i SFLASH Parameter Reading ‘ ]

o | —— ‘ . .
s ﬁ EZ-BLE current ]
ECO Startup in
- .. . ..., | boootloadaple L T I R Lo ,

2,nv Offset:20.0mV  1MQ By:20.0M A -fmv 1.0s 10.0kS/s 100ps/pt
10.0mAldiv 1MQ By:20.0M Stopped

1. Power Up and Bootloader Start

Figure 6-2. BLE Advertisement States

1acqgs RL:100k

Auto

ent

The code starts executing from the bootloader which can be found in the UART_Bootloader project. The code is optimized
to read the USB detect line (P3.5 of EZ-BLE) and immediately switch to Bootloadable code if the detect line was not

detected.
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Figure 6-3. Power Up and Bootloader Start

CyGlobalIntEnable;
if (USB_DETECT Read())
{

UART Start();

CyDelay (100u) ;

UART UartPutString ("UART Bootloader Starting. It will take 10s.\r\n");

/* This API does the entire bootload operation. After a succesful
* bootload operation, this API transfers program control to the
* new application via a software reset */

CyBtldr Start();

else

/* Schedule Bootloadable to start after reset */

Bootloader SET RUN TYPE (Bootloader START APP);

CySoftwareReset () ;
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2. System Initialization and Low Power Startup

Once the bootloader launches the bootloadable application, the code from the EH_Motherboard PSoC Creator project
starts. This code begins with low power startup functions. This allows the system to conserve power during clock startup,
especially the WCO which takes two seconds for startup. This is crucial to allow the project to survive on solar power.

Power On

‘ T S6AE101A Output Voltage

e

L LI YL L L L N

A

i Bootloaqler Start arpd } } | , ; ;
R
Software Reset ECO Startup in

boootloadable I

3
|

\ J

EZ-BLE current
System Sleep/Deep Sleep

""I"";""\""I""

el
@u}v Offset:20.0mV  1MQ By:20.0M A -ftzv 1.0s  10.0kS/s 100ps/pt
10.0mA/div 1M0 By:20.0M Stopped

1acgs RL:100k

Auto

Figure 6-4. System Initialization and Low Power Startup

CyGlobalIntEnable;

/* Set the divider for ECO, ECO will be used as source when IMO is switched off to save
power, to drive the HFCLK */

CySysClkWriteEcoDiv (CY SYS CLK ECO DIV8);

/* If USE WCO FOR TIMING is set, then do the following:
* 1. Shut down the ECO (to reduce power consumption while WCO is starting)
* 2. Enable WDT to wakeup the system after 500ms (WCO startup time).
* 3. Configure PRoC BLE device in DeepSleep mode for the 500ms WCO startup time
* 4. After WCO is enabled, restart the ECO so that BLESS interface can function */
#if USE WCO FOR TIMING
CySysClkEcoStop () ;
WDT Interrupt StartEx (WDT_ Handler) ;
CySysClkWcoStart () ;
CySysWdtUnlock(); /* Unlock the WDT registers for modification */
CySysWdtWriteMode (SOURCE COUNTER, CY SYS WDT MODE INT);

CySysWdtWriteClearOnMatch (SOURCE COUNTER, COUNTER ENABLE) ;
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CySysWdtWriteMatch (SOURCE COUNTER, COUNT PERIOD WCO) ;
CySysWdtEnable (CY SYS WDT COUNTERO MASK) ;

CySysWdtLock () ;

CySysPmDeepSleep(); /* Wait for the WDT interrupt to wake up the device */
(void) CySysClkEcoStart (2000u) ;

CyDelayUs (500u) ;

(void)CySysClkWcoSetPowerMode (CY SYS CLK WCO LPM) ; /* Switch to the low power mode
*/

CySysClkSetLfclkSource (CY SYS CLK LFCLK SRC WCO);
CySysWdtUnlock () ;

CySysWdtDisable (CY SYS WDT COUNTERO MASK);
CySysWdtLock () ;

#endif

3. System Clock Setting
System is set with IMO at 12 MHz and ECO at 3 MHz.
4. SFLASH Parameter Reading

The user flash read is done at every start of the bootloadable to read the stored beacon data in SFLASH and then used for

broadcasting. The flash read is done in CYBLE_EVT_STACK_ON to allow some breathing space between system on and flash
read.

5. WDT Configuration and BLE Beacon Starting

WDT counter is configured for startup waiting. Then, ProcessBeaconEvents() is called to process BLE Beacon events.

T S6AE101A Output Voltage

‘ . BLE Advertisement \ ‘ i i ‘

EZ-BLE current

(Cc1 )2.0v  Offset:20.0mV  1MQ §y:20.0M A -_,ftzv 1.0s 10.0kS/s 100ps/pt
10.0mA/div MO By:20.0M Stopped

(zici)2.0v 20.0ms 3.43s 3.63s 1 acgs RL:100k
10.0mA 20.0ms 3.43s 3.83s Auto

Figure 6-5. WDT Configuration and Starting of BLE Beacon
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void ProcessBeaconEvents (void)

if (wdt trigger on flag)
{
CYBLE API RESULT T apiResult;
switch (beacon state)
{
case BEACON WATIT:

beacon state = BEACON START;

break;

case BEACON START:
/* Stop I2C_COUNTER, and start advertisement */
CySysWdtUnlock () ;

/* Unlock the WDT registers for modification */

CySysWdtDisable (CY SYS WDT COUNTERI MASK) ;
CySysWdtLock () ;

apiResult = Beacon GappStartAdvertisement (interval);

if (apiResult != CYBLE ERROR OK)
{
CYASSERT (0) ;
}
beacon_state = BEACON_RUN;
break;
default:
break;
}
wdt_trigger on flag = false;

{/* If I2C COUNTER triggers a new interrupt after another 3 seconds. */

/* Wait two secounds to earn enough power to start advertising */

/* If fails to start advertisement, halt the processor.

*/
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6.4 WSN with BLE Beacon Process

This section provides detail information of WSN with BLE Beacon Process.
0. Complete WSN with BLE Beacon Process

The complete WSN with Beacon process involves running the 12C state machine on each WDT interrupt and to send new
data as part of ADV packet. The waveform in Figure 6-6 shows the various states in rotation.
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)
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T

'Bootloa!er Start and 12C gtart and 1

[ System Clock Setting [’C Read Temp and 12C Read Temp and-
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-~ ECO Startupin @ 2C Read 2C Read ]
N boootloadable Humidity Data Humidity Data 7
ool L] L ) _

@z‘nv Offset:20.0mY  1MQ By:20.0M
1o.nmAfuiv MO By:20.0M

Stopped
1 acqs
Auto

RL:100k

Stop Advertisement
~Software Il?eset ‘ | Sensor Injtialize | P | | |
NCBYAL 2.0s  5.0kSis 200ps/pt

Figure 6-6. Various States of Rotation
1to 4. Same Process as BLE Beacon
See process 1 to 4 of 6.3 BLE Beacon Process.

5. Components Start and WDT Configuration

Along with BLE start, WDT counter is configured for periodic interrupts to run the I2C state machine. This state machine
initiates 1°C and reads the data from the sensor to send it as part of the Advisement (ADV) packet. Also,

CyBle_ProcessEvents() is called to process BLE events.

CySysWdtUnlock () ;
CySysWdtDisable (CY SYS WDT COUNTERO MASK) ;
CySysWdtWriteMode (I2C_COUNTER, CY SYS WDT MODE INT) ;
CySysWdtWriteClearOnMatch (I2C COUNTER, COUNTER ENABLE) ;
#if I2C_SENSOR ENABLE

/* If I2C sensor is enabled and sensor setting is on. */

if (Sensor Flag)

{

CySysWdtWriteMatch (I2C COUNTER, I2C COUNT PERIOD);
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else
#endif
/* If I2C sensor is disabled or sensor setting is off. */
{
CySysWdtWriteMatch (I2C COUNTER, ((uint32)32767*3));
}
CySysWdtEnable (CY SYS WDT COUNTER1 MASK) ;

CySysWdtLock () ;

6. 1°C Read Humidity Data

After 12C is started, the next state reads the relative humidity value from 12C sensor and updates the ADV packet with new
humidity data. The system then goes back to deep sleep.

Note: Si7020_WriteRead(I2C_buffer, 1, 2); 1 = number of write byte, 2= number of read byte
7. 1°C Read Temperature Data and BLE Advertisement

At next WDT interrupt, the system wakes up and enters the 12C temperature state. Here the 12C data for temperature is read
and ADV packet is updated with this new data. Also, the GAP Advertisement is started so that the new ADV packet can be
transmitted by BLE.

S6AE101A Output Voltage

EZ-BLE current

Bt Ay A e bbb A Vbl A AR AR 4R AL S

(61 )20V Offset:20.0mV 1MQ By:20.0M NCGRYAE 2.0s  5.0kSls 200ps/pt
10.0mA/div 1MQ §y:20.0M Stopped

@2.0\0‘ 20.0ms 5.64s 5.84s 1acgs RL:100k
10.IImA 20.0ms 5.64s 5.84s Auto

Figure 6-7. 1°C Read Humidity Data

case I2C READ TEMP:
/* Read Temperature data from I2C Sensor */
I2C buffer[2] = SI7020 READ TEMP;

Si7020 WriteRead (&I2C buffer[2], 1, 2);
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if (apiResult != CYBLE ERROR_OK)
{
CYASSERT (0) ;

}

CyBle ProcessEvents() ;

/* Set next I2C state */
i2c_state = I2C_STOP_ADV;

break;

/* If fails to start advertisement, halt the processor.

/* Update Temperature index of ADV packet with new value */

cyBle discoveryData.advData[ADDR TEM OFFSET]= I2C buffer[2];

/* When sensor used, advertise interval is fixed to 10.24s. */

apiResult = Beacon GappStartAdvertisement (ITRVL SENSOR ON) ;

*/

8. Stop Current BLE Advertisement

At the next WDT interrupt, the stop advertisement API is called to stop the current advertisement. This is required before

the ADV packet can be updated with new data in next I12C state.

e ———————————————

T S6AE101A Output Voltage

o b gl b b b L b daaaa b

1.n\r Offset:20.0mV  1MQ By:20.0M A -j'mv 2.0s 5.0kSis 200ps/pt

10.0mAldiv MO By:20.0M
0V 20.0ms 7.755 7.95s

10.I'lmA 20.0ms 7.75s 7.95s

Figure 6-8. Stop Current BLE Advertisement
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6.5 BLE Beacon Format

BLE Beacon is a one-way communication method that broadcasts at a regular interval. It consists small packets of data (30
bytes) of Advertisements.

Beacons that want to be discovered can be used for a variety of smartphone or computer applications to trigger push
messages, app actions, and prompts.

Following is a link layer format of BLE for Advertising channel packet format. The link layer of BLE has Preamble, Access
Address, Protocol Data Unite (PDU), and CRC. Note that following information are for Advertising channel packets format;
the information does not include Data channel packets.

B "Preamble" must set "10101010b"

B "Access Address" must set "10001110100010011011111011010110b (OXx8E89BED6)"
®  "PDU" has "Header" and "Payload"

The packet structure of BLE Beacon belongs to "Advertising Data" in "Payload".

Preamble Access Address PDU (Protocol Data Unit) CRC
8) (32) (16 to 312) (24)
Header Payload
(16) (as per the Length field in the Header)
Pou | RE [ x| Rx | | RF AR AdvData
Type u Add | Add (6? u Address Advertising Data
4 @1O1 O () 48) (0-248)
Public device Addre: AD Structurel AD Structure2
Compan Compan
y_assign id Len | AD | AD | Len | AD | AD
ed yZ_AIl gth type | data gth type | data
() means “Bit” (24) @9
Random device Addres!
hash random
(24) (24)
Figure 6-9.BLE Packet Format
Figure 6-10 shows the detail of BLE Beacon packet format for the Kit.
AdvData “Byte”
Advertising Data [1means "Byte”
[30]
Len AD AD Len AD
gth type data gth type Al?zté?ta
[1 [ 1 1] [1]
AD AD
Len AD Len Company Devic Len . . RS
gt [ P | data | g2 | ¥B° D e | ging vt M[az]]"’ M['g]‘” si
[1 i 1 (1 i [21 1 [1 1

Figure 6-10. BLE Beacon Packet Format

Table 6-2 lists the initial values in the example project for Solar-Powered BLE Beacon Operation.
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<BLE Beacon Format>

Length 0x02

AD type 1 0x01

AD data 0x04

Length2 Ox1A

AD type 2 OxFF

Company ID 0x0131 [Cypress Semiconductor Corporation]
Device type 0x02

Length3 0x15

uuID’ 00050001-0000-1000-8000-00805F9B0131 [hex]
Major® 0x0001

Minor® 0x0001

RSSIY 0xC3 [-61dBm]

<Others>

Transmitter power 3 dBm

Advertise interval 1500 ms

Table 6-2. Initial Values

The kit uses ReadAndApplyConfig function in main.c to update the BLE Beacon packet. Note that the kit does not use GAP
Settings of Configure 'BLE' on TopDesign.cysch, because the SFLASH parameter is read and the BLE Beacon packet is
updated when the Motherboards turns the power ON.

" This is a 16-byte string used to differentiate a large group of related beacons.
8 This is a 2-byte string used to distinguish a smaller subset of beacons within the larger group.
® This is a 2-byte string meant to identify individual beacons.

10 Received Signal Strength Indication. This is used to determine proximity (distance) from the beacon.
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6.6 Sensor Transmitter Specification of WSN

When the “SENSOR” command is ON, the kit transmits the sensor data in the Beacon protocol packet where temperature
and humidity sensor information are stored in the Minor region (2 bytes). Humidity data is stored in the upper byte and

temperature data is stored in the lower byte.

AdvData
Advertising Data
[30]

means “Byte”

Len AD AD Len AD

gth type | data gth type A?Z%?‘a

[1] 1] [1] [1] [1]

AD AD HU

Len AD Len Company Devic Len . TE RS
gth1 ‘yfe data | gth2 tyge ID e | otha Li;’G']D M[""ZJ]Or ’;’_'F'YD P | s
1 1 1 2 1 1 1 1
[1] [ [1] [1] o [2] [1] [1] ¥} [1] (1

Figure 6-11. BLE Beacon Packet Format with Sensor Information

Meanwhile, whether temperature or humidity sensor information is written on Minor region is set by changing the ON/OFF
status with the "SENSOR" command as described in 4.3 Serial Command List. If you set the SENSOR OFF, the board will

send data based on the Beacon protocol excluding sensor information.
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7 Energy Harvesting PMIC (S6AE101A)

This section provides the specification of the Energy Harvesting Power Management IC (S6AE101A) on the Energy
Harvesting Motherboard. See the datasheet of S6AE101A (DS405-00026) for the latest information.

Figure

21 EZ-BLE

7-1. S6AE101A Energy Harvesting PMIC

7.1 Recommended Operating Conditions

Value
Parameter Symbol Condition Unit
Min Typ Max
Power supply voltage 1 (*1) Vvbp VDD pin 2.0 3.3 5.5 \%
Power supply voltage 2 (*1) Vyear VBAT pin 2.0 3.0 5.5 \%
VOUT1 setting resistance Rvout Sum of R1, R2, R3 10 - - MQ
VDD capacitance C1 VDD pin 10 - - uF
VINT capacitance Cc2 VINT pin 1 - - uF
VOUT maximum setting voltage Vsysh VSTORE1 pin 1.25 - 5.2 \%
VOUT minimum setting voltage VsysL VSTORE1 pin 1.1 - Vsysn x 0.9 \%
Operating ambient temperature Ta - -40 - +85 °C
*1: When GND = 0V
Table 7-1. Recommended Operating Conditions
7.2 DC Characteristics
Value
Parameter Symbol Condition Unit
Min Typ Max
Minimum Input power VDD pin,. Ta = +25°C, VyourH setting =3V,
in start-up Wstagr 5\;; fggol/yln? 0.4pAto VDD, when VOUT1 reaches - - 1.2 MW
o after the point when VDD reaches 3V.
VDD pin input current, VDD=3V,
Consumption current lani Open VBAT pin, Vyouri=1.25V setting, Ta=+25°C, - 250 375 nA
SET_VOUTFB resistance>100MQ, VOUT1 Load=0mA
OVP detection voltage VoveH 5.2 5.4 5.5 \%
OVP release voltage VoveL VDD pin 5.1 5.3 5.4 \Y
OVP detection hysteresis VoveHys - 0.1 - \%
OVP protection current love VDD pin input current 6 - - mA
Table 7-2. DC Characteristics
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8.1 Energy Harvesting Motherboard
8.1.1 Board Detall

The Energy Harvesting Motherboard consists of the following blocks shown in Figure 8-1:
B Energy Harvesting Power Management IC (S6AE101A)

®  EZ-BLE PRoC Module (CYBLE-022001-00)

m  USB Serial Converter IC (CY7C65213)

® | DO for USB bus power (MB39C022G)

B Temperature and Humidity Sensor (Si7020-A10)

®  Diode Bridge for the vibration energy input (1SS383 x2pcs)

®  USB mini-B connector

® Jumpers with socket to select power supply

B MiniProg3 programing header for EZ-BLE

®  10-pin expansion header for Energy Harvesting Power Management IC
®  10-pin expansion header for EZ-BLE

m  USB power LED, Status LED

®  Push switch for EZ-BLE reset

®  Pads of DIP switch for future expansion (optional)

®  Pads for BK-885-coin battery holder (optional)

®  Pads for AM-1801 or BCS4630B9 solar cell (optional)
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CYBLE-022001-00
EZ-BLE module

Status LED

Power select
header

Expansion
header for PMIC

Diode Bridge

Expansion header
for EZ-BLE

Power LED

Hardware

USB Connector
Figure 8-1. Energy Harvesting Motherboard

8.1.2 Input/Output Pin Description

Temperature and Humidity
Sensor

EZ-BLE
Debug Connector

PMIC

CY7C65213
USB serial converter

MB39C022G
3.3V LDO

S6AE101A
Energy Harvesting

Expansion Pad
for DIP Switch

BARCODE

SN e
1D yioTves 4 .E

Expansion Pad
for Solar Cell

Expansion Pad
for Coin Battery
Holder (BK-885)

Circuit Pin No. | Silk-Printed Name I 1/10 Description
Expansion pins for S6AE101A Energy Harvesting PMIC (J1)
J1-1 GND - GND pin
J1-2 VBAT | Primary battery input pin for Hybrid operation
J1-3 AC- | AC- voltage input for vibration energy
J1-4 AC+ | AC+ voltage input for vibration energy
J1-5 SOLAR+ | Solar cell input
J1-6 GND - GND pin
J1-7 VSTORE O Storage output pin
J1-8 GND - GND pin
J1-9 GND - GND pin
J1-10 VOUT (0] Output voltage pin
Expansion pins for EZ-BLE PRoC Module (J2)
J2-1 GND - GND pin
J2-2 P0.4 110 GPIO P0.4 of EZ-BLE
J2-3 P0.5 I{e] GPIO P0.5 of EZ-BLE
J2-4 P3.6 110 GPIO P3.6 of EZ-BLE
J2-5 P3.7 110 GPIO P3.7 of EZ-BLE
J2-6 TXD O UART TXD of USB serial (RXD of EZ-BLE)
J2-7 RXD | UART RXD of USB serial (TXD of EZ-BLE)
J2-8 SCL (¢} 12C clock pin of EZ-BLE
J2-9 SDA 110 I2C data pin of EZ-BLE
J2-10 VDD Power Supply Input

Table 8-1. Input/Output Pin Description
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GND P04 P05 P36 P37 TXD RXD SCL SDA VDD

J2-1 ® @ © © ' | @& 3 J2-10
o -8 ‘ :

11 J1-10

SOLAR+ VSTORE

T T I

8.1.3 Debug Connector Description

Circuit Pin No. Silk-Printed Name 110 Description
J5-1 VDD | Power pin
J5-2 SWDIO 110 SWD data pin
J5-3 GND - GND pin
J5-4 SWDCLK I/0 SWD clock pin
J5-5 GND - GND pin
J5-6 N.C - Non-connection
J5-7 GND - GND pin
J5-8 N.C - Non-connection
J5-9 GND - GND pin
J5-10 XRES | Reset pin of EZ-BLE

Table 8-2. Debug Connector Description

J5
EZ-BLE
Debug Connector

Figure 8-3. Position of Debug Connector
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8.1.4 Jumper Description
Circuit Pin No. Description Default Settings
J3 0Q resistor for bridge rectifier of vibration harvester Short
3pin jumper with socket for power source select of EZ-BLE
J4 EH: 3.3V to 1.9V Energy Harvesting PMIC VOUT EH
USB: 3.3V LDO output via USB bus power
Table 8-3. Jumper Description
J3 J4
0(_) registor for 3pin jumper with socket
Vibration harvester for power source select
Figure 8-4. Position of Jumper
8.1.5 Switch Description
Circuit Pin No. Silk-Printed Name Description
SW1 DIP switch connection to GPIO P4.1 of EZ-BLE PRoC Module for
SWA1 .
(Not mounted) future expansion
Sw2 XRES SW2 Reset Button for BLE module

Table 8-4. Switch Description

SW1
DIP Switch (Not mounted)

SW2 Reset Button

- T I YRe 2
Figure 8-5. Position of Switch

8.1.6 LED Description

Circuit Pin No. Silk-Printed Name Description
LED1 LED1 P3.4 Status LED (GPIO P3.4 of EZ-BLE)
LED2 LED2 VBUS USB power LED

Table 8-5. LED Description

LED1
LED2 Status LED

USB power LED

Figure 8-6. Position of LED
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8.1.7 Circuit
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8.1.8 BOM List
No | Qty Reference Parts Number Description Manufacture Note
1 2 C1, C2, (C3) GRM31CR60J107ME39K 100 pF/1206 TDK Corporation C3 Non-mount
2 3 C4, C5, C16 GRM188R61C105KA93D 1 uF/0603 TDK Corporation
3 3 Ce, C7,C8 GRM188R61C106MA73D 10 uF/0603 TDK Corporation
4 1 C9 GRM1885C1H222JA01D 2.2 nF/0603 TDK Corporation
C10, C11,
5 6 C12, C13, GRM188R71C104KA01D 0.1 uF/0603 TDK Corporation
C14, C15
6 3 D1, D2, D3 CG0402MLC-05LG TVS/0402 Bourns, Inc.
TOSHIBA
7 2 D4, D5 1SS383 DUAL DIODE CORPORATION
TOSHIBA
8 1 D6 1SS417 DIODE CORPORATION
1 D7 SD05-7 DIODE Diodes Incorporated
10 1 F1 1206L050/15YR FUSE 500mA Littelfuse
11| 2 |L1,L2 BLM21PG331SN1D 330 Q @ 100MHz g";‘rat? dMa”“faCt“””g
12 2 LED1, LED2 LTST-C191KGKT GREEN Lite-On Inc
. Cypress
13 | 1 | U1 CY7C65213-32LTXI USB-UARTLP Bridge | gomiconductor
Controller )
Corporation
. Cypress
Energy Harvesting .
14 1 U4 S6AE101A Power Management IC gemlcon_ductor
orporation
Cypress
15 1 us MB39C022G 1ch DCDC, 1ch LDO Semiconductor
Corporation
Cypress
16| 1 |Us CYBLE-022001-00ES Blustooth Low Energy | g0 iconductor
Module .
Corporation
17 [ 1 |7 S17020-A10-GM1 ;emp & Humidity Silicon Labs
ensors
Panasonic
18 3 R1, R2, R3 ERJ-2GEJ103X 10 kQ/0402 Corporation
19| 1 | R4 ERJ-2GEJ104X 100 kQ/0402 Panasonic
Corporation
Panasonic
20 1 R5 ERJ-2GEJ472X 4.7 kQ/0402 Corporation
21| 1 |Re ERJ-2GEJ471X 4700/0402 Panasonic
Corporation
2| 1 |R7 ERJ-2GEJ331X 3300/0402 Panasonic
Corporation
23 2 R8, R9 CRCWO06036M80FKEA 6.8 MQ/0603 Vishay Dale
24 1 R10 RCO0603FR-074M7L 4.7 MQ/0603 Yageo
25 1 R11 MCRO3ERTF10R0 10Q/0603 Rohm Semiconductor
26 0 (SW1) CHS-01TA 1pin DIP Switch Copal Electronics Inc Non-mount
. ALPS ELECTRIC
27 1 SW2 SKRPACEO010 Push Switch CO. LTD
28 0 V1) BK-885 Coin Battery Holder - Non-mount
20 | 1 | J1,(J2) PRPCO10SAAN-RC 2.54mm 10pin Header 23:'31?.3 nCS°“”e°t°r J2 Non-mount
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No | Qty Reference Parts Number Description Manufacture Note
30 | 1 |J3 ERJ-3GEYOR0OV 00/0603 ga”as"”.'c
orporation

2.54mm 3pin Header Sullins Connector
31 1 J4 PRPCOO3SAAN-RC with socket Solutions
32 1 |J5 3220-10-0100-00 1:27mm 10pin Box CNC Tech

Header
33 1 |J6 UX60SC-MB-5ST USB Mini Connector irose Electric Co.
34 2 TP1, TP2 TEST_PAD_3.0x4.0 - -

8.2 BLE-USB Bridge

8.2.1 Board Detall

The BLE-USB Bridge consists of the blocks shown in Figure 8-7. The initial firmware programmed into the BLE-USB Bridge
does not support the CySmartTM Software Utility. Instead, the firmware is a custom version used for demonstrating the
features of this kit.

m  CYBL10162-56LQXI PRoC BLE device

m  CY8C5868LTI-LP039 PSoC 5LP programmer and debugger
B Antenna matching network (AMN)

®  Wiggle antenna

® 24-MHz crystal

®  32.768-kHz Crystal (bottom side)

B PRoC BLE external programming header

B PSoC 5LP Programming test points

®  PRoC BLE reset button

m User button

m  Power LED
m  Status LED
m  User LED

®  Pads for P1_4 (PRoC BLE)
®  Pads for P1_5 (PRoC BLE)
®  USB plug
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Antenna matching
network (AMN)

CYBL10162-56LQXI
PRoC BLE device

Power LED

PSoC 5LP

Figure 8-7. BLE-USB Bridge

8.2.2 Test Pin Description

Programming test points

~ EMBEDDED IN TOMORROW™ Hardware
CY8C5868LTI-LP039
PSoC 5LP programmer
PRoC BLE external programming header and debugger

User LED User button P1_4 (PRoC BLE)

P1_5 (PRoC BLE)
32.768-kHz = e etk [ =

Crystal (bottom side) 2y Status LED
Wiggle antenna P USB plug

Circuit Pin No. Circuit Name 110 Description
TP1 BLE_TEST1 /0 GPIO P3.0 of PRoC BLE
TP2 BLE_TEST2 /0 GPIO P0.4 of PRoC BLE
TP3 VDDA - Power Pin of PRoC BLE
TP4 VDDR - Power Pin of PRoC BLE
TP5 VDDD - Power Pin of PRoC BLE
TP6 VBUS - Power Pin of USB Bus
TP7 GND - GND pin
TP8 P5LP_SWDIO I{e] SWD data pin of PSoC 5LP
TP9 P5LP_SWDCLK /0 SWD clock pin of PSoC 5LP
TP10 GND - GND pin
TP11 P5LP_XRES I Reset pin of PSoC 5LP
TP12 P5LP15_4 /0 GPIO P15_4 of PSoC 5LP
TP13 VBUS - Power pin of USB Bus
TP14 BLE_TX e} UART TXD of USB serial (RXD of PSoC 5LP)
TP15 BLE_RX I UART RXD of USB serial (TXD of PSoC 5LP)

Table 8-6. Test Pin Description

8.2.3 Switch Description

Circuit Pin No. Silk-Printed Name Description
SWi1 RESET Hardware Reset Button
SwW2 USER BUTTON User Button of PRoC BLE

Table 8-7. Switch Description
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SW?2 User button
SW1 PRoC BLE reset button
Figure 8-8. Position of Switch
8.2.4 LED Description
Circuit Pin No. Silk-Printed Name Description
LED1 USER LED1 GPIO P3.3 of PRoC BLE
LED2 STATUS LED2 GPIO P3_1 of PSoC 5LP
LED3 POWER LED3 Power LED of PSoC 5LP
Table 8-8. LED Description
LED1 User LED LED2 Status LED
LED3 Power LED
Figure 8-9. Position of LED
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SWDCLK CHSWDCLK

VTARG
R26 ZEROQ
SWDIO A
b 1 {SHSWDIO
= ; 5 P5LP12_2 | R12 ZERO
»a PoLPI1Z 3
E ; 3 4
5 56—
o R13 ZERO
g 13 *P5LP12 4

IXRES >>‘XRES

<

S0MIL KEYED SMD

PRoC Program/Debug Header

PSLP12 7

P5LP12.6 ><Ef_:t§:§—g
B2 SPlPi2 s
SeET T <PoLP12_1
PR e

PSoC B5LP and PRoC BLE Connections

22 N XTAL32|
6 pF 1
I:IY1
32.768KHz
23 o XTAL320
18 pF

kHz Crystal

XTAL240

MHz Crystal

Crystals

4 2 Y2
24MHz
- XTAL241

BLE_BIND

R7 LED1
BLE _STATUS

820 ohm

User Button Switch and User LED

2 'Fiﬂ 1

User LED Blue

VTARG
PSLP2_B
P5LP2_7
R9 R1D
23K 22K
o —| -+
Tk k|
NTZD3152P
e
@ “| R14 ZzERO
PSLP12_1 SDA_vnsoa
R15 ZERO
PSLP12 0 sCL -
sl
I2C Connection
P VBUS
VBUS
RO LOAD L
(3]

F1
PTC Resettable Fuse

USE A PLUG -

J1
VBUS
DM

DP

SLP_DM
FSLP_DP

GND
51
52 11— 11

USB APLUG

afin| 4 |eofra] =

o1
D2
D

—Pt
P

100K R21

|1
IE
€39 0.01uF

ST N

USE Connection

Solar-Powered Internet of Things (1oT) Device Kit User Guide

Doc. No. 002-00297 Rev. *B

68



A

ws CYPRESS

~ EMBEDDED IN TOMORROW™ Hardware
g ’
VCCD $3 VDDA VREF
L &
A\ .
BLE P3 2 OS> EXTRA
NO LOAD NO LOAD 0 Zero Ohm
TP1 TP2 ?% E h
(a¥]
SBE] & 2 NO LOAD NO LOAD
5] ) 2] o TP14  TPi5
Lt o et w L
aEEEl @ @
~|wo|w|w —|o|m|a ~|o|uls M
E g VDDD U1 mmmwﬂﬁﬁgmmuwvuvwﬁ
w 1| OOC~OWSTONTO LWL ~O© |>E =
= = TONrmommomerooWao o
L w ooYoooooooopXoo E w
3 @ 1 e = 52 G-
. VDDD P25
O 2
ﬂitggl' 51 XTAL320/P6.0 P2.4
YRES 7| XTAL321/P6 1 P23 VDDA
IXRESY) - XRES P22
§: P4.0 P2.1
P4.1 P2.0
ANT1
%_ Eg-? CYBL10162-56LQXI VE?’? %
ANTENNA VDDR : K
- T 10 | VSSD P16 [33 BLE TX
c19 11| YDDR P15 32 BLE RX >? SLP12.6
( 75| GANTI P14 53 {PELP12_7
s * 1| T3 ANT P1.3
12 pF 74| GANT2 P1.2
12 pF 5.1nH VDDR Q P11
C20 o o
L1 [T Bl o
= e A T = B A
| NO LOAD KRR SRReRSRRERs
<L olet-lelelols fels/ae it
<9l aklzil [ SWDCLK ¢swpCLK
o2lnlo SWDIO R
VDDR c_cl c_(' == 8 ] ILE —<<>>5WD|[-}
':2 '; (NN} WA} (NN} NN LU
Y WD ) —
0 o0 |0 oo [ia]
NN
(ToJl Ty Pe]
[ L
R Fy R
TTLn vDDD
Zg83
oo o
PRoC BLE and Antenna
Solar-Powered Internet of Things (1oT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 69



o CYPRESS

~ EMBEDDED IN TOMORROW™ Hardware
VDDR
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8.2.1 BOM List
No | Qty Reference Parts Number Description Manufacture Note
C1, C4, C6, C7, C9,
C11, C14, C16, C25, .
1 17 C28, C29, C32, C35. C1005X5R1A104K050BA 0.1 yF/0402 TDK Corporation
C36, C38, C41, C42
C2, C3, C5, C8, C10,
C12, C13, C15, C17, .
2 17 C18 C24. C26. C30. TMK107BJ105KA-T 1 uF/0603 Taiyo Yuden
C31, C33, C34, C40
3| 1 |cl9 500R07S1R2BVAT 1.2 pF/0402 Johanson Technology
4| 1 |c2 GRM1555CTH360JA01D | 36 pF/0402 '\C"gralff dMa”“faCt“””g
5 | 1 |c23 GRM1555C1H180FAO1D | 18 pF/0402 Hurata Manufacturing
6 1 C39 C1005X7R1C103K050BA 0.01 pyF/0402 TDK Corporation
7 3 D1, D2, D3 CG0603MLC-05LE ESD diode Bourns, Inc.
8 1 F1 MF-MSMF050-2 FUSE Bourns, Inc.
9 1 J1 480370001 USB Type-A PLUG Molex Inc
10 1 J2 20021521-00010T1LF 50MIL KEYED SMD FCI
11 1 LED1 LTST-C171TBKT Status LED Blue LiteOn Inc
12 1 LED2 CMD17-21VGC/TR8 Status LED Green Chicago Miniature
13 1 LED3 LTST-C170KRKT Power LED Red LiteOn Inc
141 1 | L1 L-07C5N1SV6T 5.1 nH/0402 f::ansm Technology
15 2 R8, R11 ERJ-6GEYORO0V 0Q/0805 Panasonic Corporation
16 R7 ERJ-3GEYJ821V 820Q/0603 Panasonic Corporation
17 2 R22, R25 ERJ-6GEYJ821V 8200/0805 Panasonic Corporation
18 2 R9, R10 ERJ-3GEYJ222V 2.2 kQ/0603 Panasonic Corporation
R1, R2, R3, R4, R12, . .
19 9 R13, R14, R15, R26 ERJ-3GEYORO0V 00Q/0603 Panasonic Corporation
20 2 R17, R18 ERJ-3EKF22R0V 220/0603 Panasonic Corporation
21 1 R21 ERJ-2GEJ104X 100 kQ/0402 Panasonic Corporation
22 2 R19, R20 ERJ-3GEYJ153V 15 kQ/0603 Panasonic Corporation
23 2 R23, R24 ERJ-3GEYJ303V 30 kQ/0603 Panasonic Corporation
24 2 SW1, SW2 EVQ-P3401P Push Switch Panasonic Corporation
25 1 TVS1 SD05-7 5V 350W Diodes Inc.
PRoC BLE, Cypress
26 1 U1 CYBL10162-56LQXI Programmable Semiconductor
Radio on Chip Corporation
27 1 u2 NTZD3152PT1G DUAL PMOS ON Semiconductor
PSoC 5LP Cypress
28 1 UK] CY8C5868LTI-LP039 Programmable Semiconductor
System on Chip Corporation
29 1 Y1 ECS-.327-12.5-34B 32.768 kHz ECS Inc
30 1 Y2 ECS-240-8-36CKM 24 MHz ECS Inc
31| o | (c20) 500R07S1R2BVAT 1.2 pF/0402 IJ::""”SO“ Technology | Non-mount
32 0 | (C21) C0603C101K5RACTU 100 pF/0603 Kemet Corporation Non-mount
33| 0 | (c37) C1005X5R1A104K050BA | 0.1 pF/0402 TDK Corporation Non-mount
34| o | (c27) TMK107BJ105KA-T 1 UF/0603 JAYOYUDENCO., | Non-mount
35| 0 | (R5) 1623094-1 00Q/0603 TE Connectivity Ltd. Non-mount
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36 0 (R6), (R16) ERJ-3GEYJ472V 4.7 kQ/0603 Panasonic Corporation | Non-mount
TP1, TP2, TP3, TP4,
TP5, TP6, TP7, TPS,
37 | 15 | TP9, TP10, TP11, - - -

TP12, TP13, TP14,
TP15
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9 Ordering Information

Part Number

Version

Note

S6SAE101A00SA1002

Rev 1.0
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Appendix A. Other Sample Projects

A.1  LED ONOFF Project

The LED ONOFF project, available in <Install directory>/Solar-Powered |oT Device
Kit/1.0/Firmware//Other/LED_ONOFF/LED_ONOFF.cydsn, demonstrates the simple LED control.

This sample firmware only supports LED blinking control using USB bus power; therefore, reprogram the EH_Motherboard
project in the Firmware folder to restore the Solar-Powered BLE Beacon operation.

This section explains the LED_ONOFF project.

A.1.1 main.c
This file contains the main function, which only controls the turning ON and OFF of the LED. The P3.4 of EZ-BLE module
controls a status LED on Energy Harvesting Motherboard. The blinking interval is set 1000 ms.

#include <project.h>

#define ON (1u) /* P3.4 is high */
#define OFF (Ou) /* P3.4 is low */
#define BLINK INTERVAL (1000) /* 1000 ms */

int main ()
{
while (1)
{
LED Green Write (ON);
CyDelay (BLINK INTERVAL) ;
LED Green Write (OFF);
CyDelay (BLINK INTERVAL) ;
}

return 0;
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A.1.2 Flow of LED ONOFF Project
The following figure shows the flow of the LED ONOFF project.

Enter Bootloader

Start UART
Bootloader and wait
Y9 for Bootload

Is USB
connection

Command

X Bootload over
received before

detected? command till timeout? USB-UART Com
timeout
N
v N
Issue Software L
reset to enter |«

Bootloadable

v

LED_Green is ON |«

|

Wait 1000ms

|

LED_Green is OFF

|

Wait 1000ms

A.1.3 TopDesign.cysch

The following figure shows the top design for LED_ONOFF project. The Bootloadable component links the application to
the Bootloader project's hex file. A LED_Green of I/O Interface is used to control the status LED1 (P3.4).

Solar-Powered 1oT Device Kit
LED On/Off Sample Firmware

Bootloadable /O Interface
The Bootloadable component links the LED_Green pin is used to control LED1 (P3.4).
application to the Bootloader project's .hex
file.

Bootleadable

W T
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A.1.4 Process Steps

1. Open the sample project (LED_ONOFF.cypj) for this kit available at: (<Install directory>/Solar-Powered loT Device
Kit/1.0/Firmware//Other/LED_ONOFF).

Follow the menu path Build > Clean and Build All Projects. The build status will appear at the lower right side of
PSoC Creator. The build process is complete when the message “Rebuild succeeded” appears on the status bar.

n

Project _auildtgebug Tools Window Help
) |5 Build All Projects F6

& 5% & Clean All Projects

(@ projed Clean and Build All Projects

(3| Build EH_Motherboard  Shift+F6
lotherbo
lotherba = Clean EH_Motherboard

ysch |4 Clean and Build EH_Motherboard
J0ard.cy¢

5
Nh

% Generate Application

h
rSFlash.i 2] Generate Project Datasheet
AT TTSEE RET DA

3. Program the LED_ONOFF project.

a. If you use the UART Bootloader, see 5.1 UART Bootloader (Program Only). The cyacd file is generated in the
project folder of PSoC Creator:
<Install directory>/Solar-Powered loT Device
Kit/1.0/Firmware//Other/LED_ONOFF/LED_ONOFF.cydsn/CortexMO/ARM_GCC_484/Debug/
LED_ONOFF.cyacd

b. If you use the MiniProg3, see steps 6 to 10 of 5.2 PSoC Creator with MiniProg3 (Program and Debug).
The status LED on Energy Harvestlng Motherboard will turn ON and OFF for a second usmg USB bus power.

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 76



&2 CYPRESS

EMBEDDED IN TOMORROW™ Other Sample Projects

A.2  Simple BLE Project
The simple BLE project, available in <Install directory>/Solar-Powered loT Device
Kit/1.0/Firmware//Other/Simple_BLE/Simple_BLE.cydsn, demonstrates the simple BLE Beacon transmitter.

This sample firmware only supports the BLE Beacon and Bootloader with no other frills (such as I2C, flash read/write, UART
serial configuration). This project has one source file (main.c).

This section explains the Simple BLE project.

A.2.1 main.c

This file contains the main function, which only transmits the BLE Beacon as shown below. This firmware flow is same as
BLE Beacon Process except the SFLASH parameter reading. All parameters such as UUID, MAJOR, and MINOR are fixed
by the BLE Component on TopDesign.cysch.

int main ()
{
CyGlobalIntEnable;

/* Set the divider for ECO, ECO will be used as source when IMO is * switched off
to save power, to drive the HFCLK */

CySysClkWriteEcoDiv (CY SYS CLK_ECO_DIVS);

/* Start WCO & ECO in low power mode */
LowPower WCO ECO_Start();
CyBle Start (BLE AppEventHandler);

CyBle ProcessEvents();

for (;;)
{
CYBLE LP MODE T pwrState;
CYBLE BLESS STATE T blessState;
uint8 intStatus = 0;
/* BLE stack processing state machine interface */
CyBle ProcessEvents();
/* Configure BLESS in Deep-Sleep mode */
pwrState = CyBle EnterLPM(CYBLE BLESS DEEPSLEEP) ;
/* No interrupts allowed while entering system low power modes
*/
intStatus = CyEnterCriticalSection();
blessState = CyBle GetBleSsState();

/* Make sure BLESS is in Deep-Sleep before configuring system in * Deep-Sleep
mode */

if (pwrState == CYBLE BLESS DEEPSLEEP)
{

/* If BLESS is in Deep Sleep or is in the process of waking * up from Deep
Sleep, put system in Deep Sleep mode */

if (blessState == CYBLE BLESS STATE ECO ON || blessState ==
CYBLE BLESS STATE DEEPSLEEP)
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CySysPmDeepSleep(); /* System Deep-Sleep. 1.3uA mode */

}
/* If BLESS is in Active state,

* and if BLESS Tx/Rx Event is not complete, stop IMO and put CPU * to Sleep

*/
else if (blessState != CYBLE BLESS STATE EVENT CLOSE)
{
/* Change HF clock source from IMO to ECO, as IMO can be stopped * to save
power */

CySysClkWriteHfclkDirect (CY SYS CLK HFCLK ECO) ;
/* Stop IMO for reducing power consumption */
CySysClkImoStop () ;
/* Put the CPU to Sleep. 1.1mA mode */
CySysPmSleep () ;
/* Starts execution after waking up, start IMO */

CySysClkImoStart ()
/* Change HF clock source back to IMO */
CySysClkWriteHfclkDirect (CY SYS CLK HFCLK IMO);

}

CyExitCriticalSection (intStatus);

/* If restartadvertisement flag is set, which means it's the first * time cpu
goes here. */

if (restartadvertisement)

{
restartadvertisement = false;
CySysWdtUnlock () ;
CySysWdtDisable (CY SYS WDT COUNTERO MASK) ;
CySysWdtWriteMode (SOURCE COUNTER, CY SYS WDT MODE INT) ;
CySysWdtWriteClearOnMatch (SOURCE COUNTER, COUNTER ENABLE) ;
CySysWdtWriteMatch (SOURCE_COUNTER, COUNT PERIOD 1S);
CySysWdtEnable (CY SYS WDT COUNTERO MASK) ;
CySysWdtLock () ;
wdt trigger on flag = true;

}

ProcessBeaconEvents () ;
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A.2.2 Flow of Simple BLE Project
The following figure shows the flow of the Simple BLE project.

Enter Bootloader

Start UART
Is USB Bootloader and wait Command Bootload .
connection Y for Bootload received before Y- ootoad ove
. . USB-UART Com
detected? command till timeout?
timeout
N
v N
Issue Software L
<

reset to enter
Bootloadable

v

Perform Low Power
startup

l

Start WDT counter
for startup wait

l

Stop WDT counter

:

Start BLE

I

Put BLESS and
CPU to Deep sleep
(Continue
Advertisement )
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A.2.3 TopDesign.cysch

The following figure shows the top design for SIMPLE_BLE project. BLE Component is configured as a Beacon with fixed
parameter. The Watch Dog Timer is used for waking up the system when the system is in low power mode. The
Bootloadable Component links the application to the Bootloader project's hex file.

Watch Dog Timer

Watchdog timer is used for waking up
the system when the system is

in low power mode.
BLE wor

Global Signal

. . WDT—{=|WDT_Interrupt
BLE Component is configured as a Beacon - "

in non-connectable advertisement mode
with no timeout (continuous transmission).

BLE
Bootloadable
€3 Bluetooth' The Bootloadable component links the
i application to the Bootloader project's
Jhex file.
Bootloadable

Bootloadable

A.2.4 Process Steps

1. Open the sample project (Simple_BLE.cyprj) for this kit available at: (<Install directory>/Solar-Powered loT Device
Kit/1.0/Firmware/Other/Simple_BLE/Simple_BLE.cydsn/ Simple_BLE.cyprj).

2. Follow the menu path Build > Clean and Build All Projects. The build status will appear at the lower right side of
PSoC Creator. The build process is complete when the message “Rebuild succeeded” appears on the status bar.

Project | Build | Debug Tools Window Help

‘L‘S Build All Projects F6
% 5% " & Clean All Projects
@ pfongﬁ Clean and Build All Projects

|8 Build EH_Motherboard  Shift+F6

lotherbo
lotherbd =| Clean EH_Motherboard

oysch |4 Clean and Build EH_Motherboard
y0ard.cy¢
5

Nh

I 3 Generate Application

rSFlash.i 2] Generate Project Datasheet
o sl B Pmer

3. Program the Simple_BLE project.

a. If you use the UART Bootloader, see 5.1 UART Bootloader (Program Only). The cyacd file is generated in the
project folder of PSoC Creator:
<Install directory>/Solar-Powered 10T Device
Kit/1.0/Firmware//Other/Simple_BLE/Simple_BLE.cydsn/CortexMO/ARM_GCC_484/Debug/ Simple_BLE.cyacd

b. If you use the MiniProg3, see steps 6 to 10 of 5.2 PSoC Creator with MiniProg3 (Program and Debug).
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4. Run PMIC.exe. The MAJOR number 10 (fixed value by firmware) of the Motherboard is displayed on the PMIC Software
(see 4.1.4 Establishing BLE Connection for more details). Then, move the Motherboard further away from your
computer. The Received Signal Strength Indicator (RSSI) value will change and the graphic will be updated.

&5 PMIC =k

File View Help

Distance [m]
15

ID: 10

RSSI: -64 °

14
12

10
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Appendix B. Using Extra Components

B.1 10-Q Resistor for Current Measurement

This chapter explains the Solar Module, 10-Q resistor, and a Multimeter (MASTECH: MS8268, not included in this kit.) to
measure the voltage and current for the solar module using 10-Q resistor that is included in the Solar-Powered 10T Device
Kit. First, you will take measurements under constant ambient light. Then, you will vary the available light and observe the
change in the energy output of the solar module.

Solar Module

Multimeter
not included in the kit

10-Q Resistor

Cable for Multimeter
(not included.in the kit)

1. Set the Multimeter to measure DC Voltage. Connect the Multimeter to the Solar Module as shown in the figure, and
observe the DC voltage (V1).

DIGITAL MULTIMETER

Connect cables

RANGE  SELECT  REL

HOLO

Set DC Voltage

Connect cables
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2. Place your hand about 2 cm above the Solar Module to block most of the light and observe the DC voltage (V2).

3. Now, you measure the current produced by the Solar Module. Connect a 10-Q resistor to the black wire on the Solar
Module as shown in the figure.

Measurement Block

+ (O) uhmA
—AN © oo
Series Module 1002 resistor Digital Multimeter

4. Set the Multimeter to measure Current in the microamp range. Connect the positive cable of the Multimeter to the
positive lead of the Solar Module, and the negative cable to the 10-Q resistor. Observe the current (I1).

F

Connect cable

__ DIGITAL MULTIMETER

RANGE  SELECT RES

Set yA Current

Connect cable

Solar-Powered Internet of Things (IoT) Device Kit User Guide Doc. No. 002-00297 Rev. *B 83



o CYPRESS

~gg»>” EMBEDDED IN TOMORROW™

Using Extra Components
5. Place your hand about 2 cm above the Solar Module to block most of the light and observe the DC voltage (12).

6. Calculate the energy produced by the Solar Module. Calculate the Maximum Power Point (MPP!) energy of the Solar
Module.

Under constant ambient light (Example 400 Lux)

E1=(0.8xV1)x(0.8x11)=(0.8x5.87V) x (0.8 x 42.3uA) = 158.91 [uW]
Covering Solar Module with hand (Example 250 Lux)

E2 = (0.8 x V2) x (0.8 x 12) = (0.8 x 5.75V) x (0.8 X 28.0uA) = 103.04 [uW]

I-V Characteristics of Solar Module (AM-1801)

FL:White Fluorescent Light

25

[ \
200Lx FL

20

Current( it A)

50Lx FL

0 \

0.0 1.0 20 3.0 4.0 50
Voltage(V)

11 The MPP of a typical solar cell is 80% of the maximum voltage and maximum current.
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B.2  Additional 220 uF Capacitor

EHS comprises an EHD such as a Solar Module, an Energy Harvesting PMIC, and a Storage Device (such as a capacitor).
The purpose of EHS purpose is to supply power to the EHS Load. When designing an EHS, consider voltage, current, and
time in three contexts: power supplied by the EHD, power stored in the Storage Device, and power required to operate the
system.

Following is example of failed waveform for EHS. The output voltage of the S6AE101A slowly drops due to consumption,
eventually shutting down the output completely.

VOUTL Cutoff Voltage

E Active I .

Active Active R

~ Active

Deep Sleep Deep Sleep Deep Sleep Power Off

EZ-BLE Current

—
(1) 2.0vidiv 1MQ §y:20.0M Ao 21y

10.0mA/div 1MQ By:120M Stopped

1acgs RL:100k
Auto

1.0s  10.0kSis 100ps/pt ‘

One way to resolve this failure is to connect the additional 220 yF capacitor to VSTOREL of SEAE101A..

}GN D

VSTORE1

Note that J1-1

to J1-4 and J1-

9to J1-10 are
unused
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The waveform for EHS is completed to add the extra capacitor to VSTOREL pin. Note that value of capacitor depends on
the consumption energy. You can calculate the energy of capacitor using following formula.

Calculation formula for energy of capacitor

ECAP 0.5 x C x

(VOUTH2 - VOUTL2)

YT

A

<l
(@)
C
pur]
1
@]

utoff Voltage

S6AE101A Output Voltage

EZ-BLE Current

R
(1) 2.0vidiv
10.0mA/div

MO By:20.0M
1MQ By:120M

1.0s  10.0kSis 100ps/pt
Stopped

1acgs RL:100k
Auto
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